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Jim2® Business Engine v3.3 MPS Edition 
Jim2 Version 3.3 contains so many new features that we felt the changes deserved separate release notes to allow both existing 
Managed Print Services (MPS) customers, and customers new to MPS features a step by step approach to take full advantage of the 
changes specific to the MPS edition. If you are a seasoned Jim2 v3.2 MPS user, you will be aware of some of the features we will cover, 
but it’s worth reading to review the current best practice, and also to see where each new feature fits in.

The entire engine behind MPS billing has been re-designed to provide a more flexible approach to setting up MPS contracts. A raft of 
new features have been added, and many existing features expanded on to cater to the broadest range of billing scenarios possible.

Jim v3.3 actually contains two separate billing ‘engines’ for MPS. The engine that was contained in Jim2 v3.2 remains and is virtually 
unchanged. The only change of note is that the ‘3.2 engine’ was enhanced to work with standard macro format that is used in other 
parts of Jim2.

The vast majority of this document is concerned with the new ‘3.3 style’ billing engine. To take advantage of the new features and 
possibilities outlined in this document you will need to convert some or all of your existing machines to the new ‘3.3 style’ 
projects/machines. This is a process that you will need to undertake with the technical assistance of Happen, as the many additional 
checks and requirements of the new billing engine meant that this could not be included in an automated upgrade process.

Having the two engines does give you the major advantage of being able to upgrade to Jim2 v3.3 to take advantage of new 
features and functionality in the core product, whilst at the same time planning your migration to the new ‘3.3 MPS engine’ as 
a separate exercise. You can upgrade to Jim2 v3.3 and continue for a period of time to use the legacy billing engine with the 
knowledge that it will continue to bill as it did before. At some later point you may decide to convert all projects/machines to ‘3.3 
style’ or perhaps a subset of machines, according to your business needs.

Happen have committed to support ‘3.2 style’ machines not only in v3.3 but also in the next planned release of Jim2. We are unable 
to make a firm commitment at this time beyond that, and it is likely that support for ‘3.2 style’ machines will be dropped in some future, 
unspecified release.

These release notes will walk you through from start to finish all of the new functionality providing examples of common billing scenarios 
relevant to each new feature.

To get started with MPS we will work through the following areas:

MPS Overview
• Overview of MPS operation

MPS Setup and Configuration
• Tools – Run through on Tools > Setups and Tools > Options specific to an MPS installation
• Items – Creating an Item and setting up related Stock for each machine model
• General Ledger/StockGL Groups – Creating relevant COGS and Income Accounts and StockGL Groups for Meter Billing
• Billing Stock – Setup of Meter Billing Stock
• Consumable Stock Yields – Set up some typical Consumable Stock Yields
• Macros – Setup of the expanded Macro System in Billing Job Fault/Invoice Descriptions and Meter Invoices
• Email Templates – Setup of Email Templates to handle Page Requests, and Service and Consumable alerts

Machine Creation and Meter Setups
• Machine Contract – Setup of the administrative fields of a machine contract
• Standard Meter Setup – Standard and Service meter setup for a simple cost per copy (CPC) Contract
• Opening Balances – Setup of the machine opening balances for a new machine Contract
• Multiple Counter Setups – A4/A3, Expressive Colour, etc
• Unders/Overs Meter Setup – Meter setup for a simple volume contract, including unders and overs
• New Meter Types – Explanation of the new 3rd Party PO Meter Types
• New Meter Options – Meter Start/End Dates and Multiple Billing Frequencies
• Prepaid Pages – Prepaid Meter Setup including Free Pages Setup
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Master Machine Creation and Meter Setups
• Master/Child relationships – Linking Master and Child Contracts. Copying data between Master and Child Contracts
• Split Meter Setups – Setting up a split meter between Rental/Service using kitting
• Print Management Plan (PMP) Meter Setups – Common PMP Meter setups
• Clawback Meters – Setting up a Machine Meter or Master Contract with Clawbacks.
Meter Billing Engine changes
• New Meter Reading Options – Averages, Estimates, No Reading
• Meter Billing Reports – InvoiceMeter, InvoiceMeter – Master and InvoiceMeter – Master Detailed report layouts

Advanced Topics
• Upgrading from Jim2 Version 3.2 – Using the Machine Conversion Tool
• Standard Meter Scenarios – A compilation of Typical Meter Scenarios
• Advanced Meter Scenarios – A compilation of more advanced Meter Scenarios
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MPS Overview
The following is a basic overview of how MPS is implemented in Jim2. Whilst the initial setup may at first glance seem complex, it is
actually quite straight forward once it is clearly understood how it all relates.

If you are already familiar with Jim2 MPS Edition you can skip this section if you wish.

We’ll quickly run through a basic overview.

Projects/Machines/Contracts

A Project (commonly renamed to Machine, Contract, Device, or ID under MPS) is used to tie everything together and can basically be
considered the machine contract. We’ll refer to this as ‘Contract’ for the rest of this article.

A Contract keeps track of everything related to a Machine including:

• The Machine ID – the unique code that identifies this Contract/Machine
• Who owns the Machine – Links to a CardFile
• Where the Machine is located  – Links to a CardFile
• How meter reads are collected – FM Audit, Print Audit, Email, Manually etc.
• The Machine’s make/model and serial number – Links to an Item
• What Branch, SubBranch or GL Dept is related to this machine
• The contract related dates – Start/Finish
• The billing frequency – Billed Monthly, Quarterly etc.
• The billing related dates – Last Billed, Next billed etc.
• The Machines’ meter setup – Black, Colour etc.
• The Machine’s starting meter reads
• The Machine’s meter billing rates
• The Contract type – Standard Machine, Master Contract etc.
• The Machine’s Price Level – the Stock Price Level used for cost of toners, parts etc.
• All related completed (invoiced) Jobs – Billing Jobs, Service Jobs etc.
• All related incomplete Jobs –  Billing Jobs, Service Jobs etc.

Billing Cycles and Lists

Contracts are typically part of a ‘billing cycle’ based on their billing frequency. As a Contract comes up for billing (based on their 
Next Bill date) the Contract’s state will change to ‘Billing Due’. Typically meter read requests are sent out (unless the machine provides 
automated reads), in which case the Contracts state is ‘Request Sent’.

This is all managed via Contract lists. So you would create a list of ‘all Contracts that are within X days of Next Bill date’. You would then 
send meter read requests out to these customers, which changes the state to ‘Request Sent’. As reads come through they are entered 
and billing jobs are created, and the Contract is moved forward to its next billing cycle.

Typically, Contracts must always be billed every period, even if a meter read is not received. If a read is not received, an average or
estimated read can be billed, or the Contract can simply be skipped for that billing period and moved forward to the next. 

CardFile

A CardFile is a Customer or Ship/Site. All details related to this customer or site is on their CardFile.

Items

An Item is the machine make/model. This is set up once per make/model of machine. It defines if the machine is B/W or Colour, and 
what Stock (typically Toners, Consumables etc.)  that are related to this specific machine model.

Items are typically related to, and can be easily created from a Stock. So, for example, I sell machine XYZ so I have a XYZ stock code, 
so create an Item based on and linked to this Stock. For older machines or machines that you do not sell but have under Contract, you 
would simply create an Item directly.
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Stock

Stock is used extensively under MPS. It is used to bill ‘normal’ things such as Toners against this Machine. It is also used to bill meter 
related things such as pages against this machine. This is a core concept to understand. When you are billing pages, you are simply 
billing a Black Page Stock Code against this Machine.

To clarify, when you bill black pages against a Machine you are simply billing the black page stock code you have set up in this 
machine’s meter setup.

To make things easier when Stock is initially setup, you mark this Stock related to MPS, and as a ‘Black Page’ Stock code. This prevents 
using just any stock code when billing pages.  This extends to type of black page you are billing (Standard, Unders, Overs etc.) as 
explained below.

There are a number of benefits to using Stock to bill pages including:

• Meter count is simply the sum of: Meter opening balance + black page stock billed – black page stock returned
• Since stock is related to a Stock GL Group, the stock code defines where this appears in your income from an accounting point of 

view
• The Stock’s description as it appears on an invoice can be completely customised using macros (Current meter read, pages billed, 

next bill date etc.)

As we are using different stock codes for both different meters (B/W, Colour, Scans etc.) and for billing group (Standard, Under, Over 
etc.), this provides an enormous amount of flexibility from an accounting and reporting point of view.

As stated above, Stock is marked as related to MPS and as either a ‘Meter’ or ‘Yield’.

• Meter related Stock is set to a specific meter and meter type, for example Black, or Base Charge, etc.
• Yield related Stock is used for stock that is considered ‘yieldable’, and for what type of yield. For example, a Black Drum would be 

marked as yieldable, related to both a drum and the black meter, and have a yield value of 25000.

Meter Setup

A Machine’s meters are configured via the Contracts ‘Meter Setup’ tab.  In the case of a simple colour machine for example, there is
one meter for black, and one meter for colour. These are considered ‘main’ meters, or to be more precise, the ‘unlinked’ meter.

The unlinked meter is always considered the ‘meter count’ meter. That is, when billed it is the sum of the unlinked meter (invoiced
Standard + Overs + start meter value - returns) that is the current meter count.

Meters are now divided into three billing groups.

1. Standard Billing
2. Unders Billing
3. Overs Billing

Standard Billing

The Standard meter ‘information’ is required.
In the case of a machine of a normal CPC (Cost Per Copy) where there are no minimums (volume or $) this is the only meter billing
information required.

Unders Billing

Unders Billing is used when there is a minimum volume required for that meter (min black 1000 for example).
It is billed at the same rate as Standard Billing, but can billed with a different Stock/CardFile/Rate if required.
A Standard Volume must be specified. This is the minimum amount of pages that must be billed per billing cycle.
If rate not specified the Standard info will be used.

Overs Billing

Overs billing is used when the minimum volume has been achieved. 
Again, it can be billed with a different Stock/CardFile/Rate. 
If rate not specified the Standard info will be used.
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General Meter Rules

• All Billing types must be billed with different Stock Codes
• All Billing types can be hidden on invoices
• All Billing types can be flagged as ‘Non Billable’ in which case they are invoiced at 100%. This is typically used to track dollars and 

volumes, but you are not billing the end user (e.g. billed by finance company but still want to track finance)

All billing is bundled into a meter billing kit if required. A meter billing kit allows multiple stock codes to be billed against a meter, for 
example split service and finance. These are typically hidden on the invoice with only the kit header displayed.

Unlinked Meters

An unlimited number of meters can be linked to the main (unlinked) meter to allow for split billing for any purpose. Income going to
finance and service, or part of the billing going to a finance company, and the balance (say, overs only) going to you.

You could, for example, have all Standard + Unders going to the finance company, and Overs going to you, and be split by service 
and sales.

Additional Meter Types

There are a number of additional Meter Types available, including total meters, min charge meters, base charge meters, etc. These are
used for many of the various billing scenarios you may have.

These are explained in detailed later in this document, but for an example, the Total (Unlinked) meter:

The Total (Unlinked) is the value of all unlinked ‘page volume’ meters (e.g. Black and Colour). It can be used as a normal meter ,along
with its own Standard/Unders/Overs setup. It is typically used to bill paper, but can be used for any billing based on total pages

Basic Billing and Meter Types

The following is a simple example of how billing and meter types work:

Black Meter Setup

Standard BLK.UNDER .01
Unders BLK.MIN .01
Overs BLK.OVER .015

Minimum Volume = 1000

Meter Read = 1000
Standard1000x BLK.UNDER @ .01
Unders Not billed
Overs Not billed
Billed $10.00

Meter Read = 700
Standard700x BLK.UNDER @ .01
Unders    300x BLK.MIN @ .01 (Standard rate)
Overs Not billed
Billed $10.00

Meter Read = 1500
Standard1000x BLK.UNDER @ .01
Unders Not billed
Overs 500x BLK.OVER @.015
Billed $17.50

Project Type

The ‘Type’ field is used to specify the type of project. This drives many things in regards to how the project is displayed, and how the 
project is billed etc. Within Jim2 there a number of standard project types, with Machine or Master project types being typically used. 
New project types can be created in setups that are based on these system project types. For example, whilst a printer and a copier 
would both be based on the ‘Machine’ project type, you may wish to create a specific ‘Printer’ and ‘Copier’ project type.

Contract/Price Level

Contract is used to drive pricing against a contract other than meter billing. This is a ‘Price Level’ in Jim2. You would typically set up
a Price Level for each contract type you have. For example, a price level of ‘Toner all $0’, meaning that, the machine gets both black 
and colour toner @$0.00.

This allows an easy way to set up stock pricing for contracts, and is made even by using Jim2’s Price Template feature.

Any job created from a contract will use the contract’s price level. If no pricing is available for that price level, Jim2 will use the 
customer’s price level. So, in our example above, ‘Toner all $0’, toners and consumables would have this price level, but paper, staples 
etc. would not, and therefore bill these out at the customer’s normal price.
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MPS Setup and Configuration 

Tools > Setups > Job > Job Type

Add the following Job Types for use on MPS jobs:
MPS Billing, MPS Meter, MPS Onsite, MPS Workshop, MPS Consumable

 

Tools > Setups > CardFiles > Price Levels

Add your required Contract Price Levels for use on MPS jobs:

 

Tools > Setups > Stock > Price Templates

Add your required Price Templates for applying the above Contract Price Levels to your stock:
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Tools > Setups > Project > Project Types

Add your required Machine types using the add button at the bottom of the screen:
System Type Machine is the new v3.3 Machine type. Master Machine is the new v3.3 Master Machine type. Old Machine Types are 
still supported through Machine (Old), and Master Machine (Old). Having separate Mono and Colour types will allow reporting on just 
Mono Printers at a later date.

 
 

Tools > Options > Project

 
1. Ensure that Enable Projects is ticked. Your licence key will require MPS features to enable this
2. Rename Projects if required (Typically Machine or Contract)
3. Set Billing Jobs to Ready is typically ticked to Create Meter Billing Jobs on Ready status for fast Invoicing
4. When entering a Job manually, Jim2 will display the list of projects for this customer when their CardFile is selected, if the following 

option is selected
5. Prepaid reorder will reorder additional prepaid copy blocks according to this setting. For instance, if Pages are purchased in 10,000 

copy blocks and this setting is set to 90%, when the customer has only 1,000 copies remaining from their original prepaid purchase 
of 10,000 an additional 10,000 copy block job will be generated

Tools > Options > Project > Machines
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Set the Default Job types to the Job types you created earlier (MPS Billing, MPS Meter, MPS Consumable, MPS Onsite, and MPS 
Workshop). This will make it easier later to filter a list of Jobs using the type field.

Set the Linked Meter and Master Meter Kits to the Dynamic Kits you created earlier. These will be used to summarise the Meter Reading
information when you have multiple lines generated by a billing job.

Set the No Meter Read, Estimate and Leave Unders Available to the relevant Stock codes you created earlier. Examples of these 3 new
features are provided in the Example Scenarios towards the end of this document.

No Meter Read Stock Code – Including a non-depleting stock code here will enable a ‘No Read’ option when billing a machine. This 
simplifies the display of billing jobs to indicate that no read was received without having to include a zero quantity line for each meter 
on the machine.

It also allows the option of performing a ‘No Read’ on a master contract. Selecting this option when billing a master contract will 
perform a ‘No Read’ for all machines on the contract that have yet to have a read entered against it. Afterwards, it will then perform 
the usual master contract calculation. This can save a large amount of time if there are numerous machines on a contract for which no 
read has been received.

Estimate – The problem with Billing averages is the user sometimes provides an actual reading that is smaller than the average, and as 
Jim2 treats Averages as a real reading, some Admin is required to Return the Original Reading, and re-invoice that reading once the 
actual reading is received. This problem is overcome with an estimate, as Jim2 will use the Estimate Stock to bill the estimate reading at 
the time, and later take that reading into account when the Actual reading is provided. In this way, Jim2 self-balances automatically in 
cases where the Actual reading is lower than the estimated read.

Leave Unders available for Clawback – In some Volume contract arrangements, if the Customer is billed unders, they are made 
available in future periods for Clawback. We cover this example in detail in a later section, but this stock code is used to identify on 
contracts that have this arrangement that Jim2 should leave the unders open for Clawback in a later period. In addition, if Jim2 is 
billing a certain period, and the Leave Unders Stock Code is not present on the Previous Billing Jobs, it will assume that Unders are now 
closed for Clawbacks.

Meter Read Entry Period (days) – This indicates the number of days before the “Next Bill” date of a project that a job will be created. 
For example, if this value is set to “5” (the default) and the “Next Bill” date of the machine is the “28 Feb” consider the following two 
scenarios

1. Attempting to process a read on the “22 Feb” will
· For manually entered reads – give a warning that it is outside the meter billing period
· For incoming reads via an MPS connector – processing will fail

2. Attempting to process the read on the “23 Feb” will
· For manually entered reads – no warning will be shown
· For incoming reads via an MPS connector – processing will continue

3. Attempting to process the read on the “6 Mar” will 
· For manually entered reads – give a warning that it is outside the meter billing period
· For incoming reads via an MPS connector – processing will continue

Exclude Meter Reads Older than (days) – This indicates the maximum age that a read can be when processed via an MPS connector. 
This is different to the “meter read entry period” because it refers to the date the read was taken, not the date the read was 
processed.

These two settings can work in concert to allow for reads via an MPS connector to be processed at an appropriate time using the best 
available read. Consider the following scenario

Machine has next bill date of “28 Feb”
Meter Read Entry Period (days) = 5
Exclude Meter Reads Older than (days) = 15

1. A read is received via an MPS connector on the “12 Feb”. This read is permanently failed because the date is outside the meter 
read entry period (it is before the “23 Feb” which is 5 days before the “28 Feb”) and the read would be too old to use even if it was 
inside the billing window (it is before the “13 Feb” which is 15 days before the “28 Feb”)

2. A read is received via an MPS connector on the “13 Feb”. This read is immediately failed but it is rescheduled to be attempted 
again. This is because although it is too early to process the read (“13 Feb” < “23 Feb”) if it were inside the billing window this read 
would not be too old to use (“13 Feb” >= “13 Feb”)

3. Attempts to process the read from the “13 Feb” are made for the next few days, each time failing because it is too early to 
process and each time being rescheduled to try again. On the “18 Feb” a new read for the machine is captured. This new read 
supersedes the read captured on the “13 Feb” and that read is now failed permanently. The new read itself is failed because it is 
too early to process (“18 Feb” < “23 Feb”) but, as with the previous read, it is rescheduled to try again because the read could be 
used if it were inside the billing window.

4. On the “23 Feb” the machine is now inside the billing window and the read from the “18 Feb” is successfully processed, creating a 
job

In summary Jim received a read on the “13 Feb” and another on the “18 Feb” but waited until the “23 Feb” to process the best read 
available, which was from the “18 Feb”.
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The Tickboxes on the right hand side of the Options screen previously existed in Jim2 v3.2. We recommend the above settings unless you 
have a requirement to change those settings. The Group PO by Project Method now offers new choices for customers using 3rd Party 
PO meters to account for Contractor Service Agent costs on a machine. Previously these were only available on a single consolidated 
PO to the Contractor. You can now have Jim2 create a separate 3rd Party PO per Single Machine, or even per Master Contract. This 
setting is a global setting, and is overridden by a new setting in the Vendor tab of the CardFile, allowing a Global Consolidated PO for 
Each Agent by default, but in particular cases, a contractor could be set up for Single 3rd Party PO’s for each Machine or Master.

Other Options in this screen remain unchanged, except for the Default Billing Job Descriptions which now contain an expanded Macro 
system, which we cover in a later section.

Item > Add Item

Create an Item for Each Machine Model. An Item can be set up with related stock, such as Consumables and Parts so that in Jobs the 
user is prompted with the related stock for that model to add to a Consumable or Service Job. Also, the Item now specifies what type 
of Photocopier the Item is, so that only relevant Colour Meter options are shown when a Colour Copier is selected.

 
Typically, the Item Code would take the format of the machine model number, and in a large organisation servicing many different 
types of equipment could have a prefix indicating the Brand of equipment, e.g., RICOH.MPC300 to distinguish this as a Ricoh Model.

Select the Stock tab (bottom left of screen) and add the related stock used by this Model. 

Ensure you deselect the AutoAdd tickbox so that this stock is not automatically added to jobs, but instead prompts the user with a list of 
related stock.
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General Ledger & Stock GL Groups 
Accounts > General Ledger

For Meter Billing purposes, Income and Cost of Goods Accounts need to be created to record all Meter Billing Income and 
Expenditure.

You might set up something as simple as below:   Or more complex like this:

Tools > Setups > StockGL Groups

All Stock codes in Jim2 report to a StockGL Group. This StockGL group reports to the specified Stock On Hand, Income and Cost of 
Goods accounts. The Income and COGS accounts relating to Meter billing now need to be linked to a Meter Billing Stock GL Group.

Add a new Non Depleting/Journal Stock GL Group called Meter Billing:
 

If you chose a more complex setup in the General Ledger then you will need a Stock GL group for each GL to separate the Income 
and COGS.
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Billing Stock

You now need to create several MPS Meter Billing Stock Codes, and link them to the Stock GL group you just created.

Stock Code Stock Type Purpose

MC.BLACK Non Depleting Machine Black Standard Meter

MC.BLACK.U Journal Machine Black Unders Meter

MC.BLACK.O Journal Machine Black Overs Meter

MC.BLACK.S Non Depleting Machine Black Service Meter

MC.COLOUR Non Depleting Machine Colour Standard Meter

MC.COLOUR.U Journal Machine Colour Unders Meter

MC.COLOUR.O Journal Machine Colour Overs Meter

MC.COLOUR.S Non Depleting Machine Colour Service Meter

MC.RENTAL Non Depleting Machine Rental Base Charge

MC.LEASE Non Depleting Machine Lease Base Charge

MC.MINIMUM Non Depleting Machine Minimum based on $

METER Dynamic Kitting Meter Kit for simplifying customer invoices

MASTER Dynamic Kitting Master Meter Kit for simplifying customer master invoices

NO.READ Non Depleting Bill minimums only pending an actual reading 

ESTIMATE Non Depleting Bill an estimate reading pending an actual reading

LEAVE.UNDERS.OPEN Non Depleting Leave Unders Open to draw down on in a later period.
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Stock >  Add Stock

In Jim2 v3.3 there are additional constraints on what stock can be used for which meters. Each stock code can only be used with a 
specified meter type. If that meter type supports Standard, Unders and Overs billing types, then the stock code can only be used for 
the chosen meter type AND the chosen billing type.

What the stock can be used for is specified on the projects tab of the stock window. When the meter setup for a machine/project or a 
master is being edited, only applicable stock will be shown from a drop down list.

Add a new Stock Code for MC.BLACK. If you already have a Stock Code for this purpose then you will just need to edit it, adding in the 
additional information as detailed below.
 

Note that this Stock is type Non Depleting, and has the Stock GL Group ‘Meter Billing’ Selected.
 
A new Projects Tab at the top of the Stock record has been added to allow the Meter Type and Yield Type to be specified. This will 
have been renamed, if you have renamed Projects. We will cover Yields later. For now select the Projects Tab, and Select the Meter 
Type radio button, then in the Meter Type List box select Black. In the Billing Type List box select Standard. This Stock code will be used 
for Standard Black Meter Counts.

Previously we stored the Meter Macros that describe the way the Meter readings look on invoices in the Long Description field of the 
stock. It has been relocated to the Projects Tab, and now has a dedicated field.

Start with a Simple Macro Description as per the previous example. We will cover Macros fully in the next chapter. For now you can 
save the Stock Code, and then create a Meter Stock code for all the Codes listed in the above table. Ensure that in each case you set 
the Stock Type according to the table, and the appropriate Meter Type and Billing Type in each case. Even though you may not use 
some of the stock codes immediately, it’s a good idea to create them so they are available when needed in the future.
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Consumable Stock Yield

Stock Yield is now available on all Consumables and Parts that have a Yield value. 

Edit the Consumable Stock, select the Projects Tab, and select the Yield Radio button, then choose from the available list of Yield 
types. Enter the Yield values for that Stock, and Expected Coverage. If this Stock Code is generally replaced as part of Kit or Spare Part 
replacement, you can select the Reset by, and select the Kit/Spare Part that Resets the Toner Yield. This would typically be because 
the Kit contains the Toner. 

If your required Yield Type is not available from the List Box you can configure additional Yield Types in:

Tools > Setups > Stock Yield Types

When set up, it may take some time for Consumable sales to affect the displayed data. In this example we are starting to see Yield 
data appear in the Preview pane on the far right of the Machine Contract.  
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Macros

Macros have been greatly enhanced in Jim2 v3.3, and are now consistent with email template macros in their functionality. Instead of 
the previous angle bracket style <macro> Jim2 v3.3 now uses the double curly braces style macros {{macro}}. As with email templates 
this allows the addition of text that will only appear if there is a non-empty value for the macro.

For example, with the macro {{‘Overs = ‘Project.Meter.Job.Over Qty}} the text ‘Overs =’ will only be displayed if there is an actual value 
for the Project.Meter.Job.Over Qty macro.

Macros are available for two purposes.

1.  To customise the Default Billing Job Fault Description, and Invoice Description. In this case ,any macro with ‘Meter’ in it is 
unavailable. The macro can be specified at a global level (See Tools | Options > Project > Machines > Default Billing Job 
Description), or can be overridden for a particular project (See View Project | Default Stock | Fault Desc. and Invoice Desc.).

2.  To customise the stock description at a job level. Macros with ‘Meter’ as a part of it are available. The macros are stock specific 
and can be edited via View Stock | Projects | Macro Desc.

There are three areas where macros can be edited:

Tools > Options > Project > Machines  
 

Project > View/Edit Project 
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Stock > View/Edit Stock

The list of available macros is available either by right clicking on the field ,or by clicking on the ‘+’ button attached to the field.

 
The number of macros has also been greatly increased. A large number of these macros will evaluate to nothing for legacy v3.2 
machines.

Macro Description Only v3.3 ?
Project.Card.Name The name of the card attached to the project/machine.

Project.Project #

Project.Serial #

Project.Missed Cycles The number of times the project/machine has had its billing skipped.

Project.Item.Code

Project.Item.Make

Project.Item.Model

Project.Item.Description

Project.Job.Bill Date For non-manual machines copier billing this is the same as the next bill date. 
Otherwise it is the submission date if supplied.

Project.Job.Date In The date the job was created. X
Project.Job.Date Due The date due on the job that was created. For copier billing jobs this normally relates 

to the ‘Next Bill’ date on the machine.
X

Project.Job.Read Date When manually entering in a read this date corresponds to the ‘Date’ field in the 
‘Billing Meter Read’ window. When a meter read job is generated via an MPS feed 
this date will contain a value if it is supplied as part of the feed.

X

Project.Job.Previous Job.Bill 
Date

This corresponds to the ‘Bill Date’ value for the previous job of the same type for the 
machine when ordered by Date Due.

X

Project.Job.Previous Job.
Date In

X

Project.Job.Previous Job.Date 
Due

X

Project.Job.Previous Job.
Read Date

X

Project.Job.Previous Job.Date 
Out

This is the date out value for the previous job of the same type for the machine when 
ordered by Date Due. This is typically the invoice date of the previous job.

X

Project.Job.Next Job.Bill Date This is the calculated ‘Next Bill’ date for the machine. It takes into account the 
current ‘Next Bill’ date and ‘Billed’ frequency.

Project.Job.Avg Bill This is only used for v3.2 machines. It will evaluate to nothing for v3.3 machines. It is 
recommended that you put a description in your ‘Bill Estimate stock Code’ (Tools | 
Options | Project Machines) for v3.3 machines to achieve the same effect.
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Meter specific macros

Macro Description Only v3.3 ?

Project.Meter.Counter 
Name

The ‘Meter Name’ as per the meter setup.

Project.Meter.Rate TF The ‘Rate Ex.’ as per the meter setup. 

Project.Meter.Rate TP The ‘Rate Inc.’ as per the meter setup. 

Project.Meter.Base TF For a ‘Base Charge’ meter type this is the ‘Rate Ex.’, otherwise this evaluates to an empty 
value.

X

Project.Meter.Base TP For a ‘Base Charge’ meter type this is the ‘Rate Inc.’, otherwise this evaluates to an empty 
value.

X

Project.Meter.Min TF For a ‘Min Charge’ meter type this is the ‘Rate Ex.’, otherwise this evaluates to an empty 
value.

X

Project.Meter.Min TP For a ‘Min Charge’ meter type this is the ‘Rate Inc.’, otherwise this evaluates to an empty 
value.

X

Project.Meter.Min – 
Base TF

For v3.2 style machines this is the Minimum charge excluding tax ,minus the Base charge 
excluding tax. For v3.3 machines this is the same as ‘Rate TF’ as minimum charges already 
exclude any base charge amounts. This macro is only supported for legacy reasons, and 
should not be used once all ‘3.2 style’ machines have been converted or finished.

Project.Meter.Min – 
Base TP

For v3.2 style machines this is the Minimum charge including tax, minus the Base charge 
including tax. For v3.3 machines this is the same as ‘Rate TP’ as minimum charges already 
exclude any base charge amounts. This macro is only supported for legacy reasons, and 
should not be used once all ‘3.2 style’ machines have been converted or finished.

Project.Meter.Effective 
Periods

Returns the number of billing periods of the machine this particular meter is being billed for. 
For a quarterly billed meter on a monthly billed machine this value will normally be 3. This 
calculation also takes into account the number of billing periods skipped. For the machine 
above, if the machine’s billing had been skipped 4 months previously this value would be 6 
as it is now billing 2 quarters.

X

Project.Meter.Missed 
Cycles

This displays the number of missed cycles. If no cycles have been missed this evaluates to 
an empty value.

Project.Meter.Min 
Charge Pages

This evaluates as the number of pages that would be required to make up the minimum 
charge. It considers who the meter is being billed to when performing the calculation (for 
example, a machine that has a Finance Black Meter, and a Service Black Meter, as well as 
a minimum (dollar) charge). A similar effect can be achieved by using a Minimum Volume 
on a Black, Colour or Scan meter.

Project.Meter.Job.Expire 
Date

If a prepaid meter generates a purchase of a prepaid block of pages this macro evaluates 
to the date that the pages expire. It is based on the ‘Next Bill’ date at the time the prepaid 
block is purchased.

Project.Meter.Job.Expire 
Meter Read

For a prepaid meter this evaluates to the meter read on the linked meter when any 
purchased pages will expire.

Project.Meter.Over 
Rate TF

The ‘Overs Rate Ex.’ as per the meter setup. This evaluates to nothing for non-rate based 
meter types.

Project.Meter.Over 
Rate TP

The ‘Overs Rate Inc.’ as per the meter setup. This evaluates to nothing for non-rate based 
meter types.

X

Project.Meter.Job.Over 
Total

The dollar amount of the total overs charged.

Project.Meter.Minimum 
Volume

The ‘Minimum Volume’ as per the meter setup.

Project.Meter.Job.Meter 
Read

The new count of the meter ignoring the effect of any estimates.

Project.Meter.Job.
Effective Meter Read

The new count of the meter including any estimated amounts. X

Project.Meter.Job.
Estimated Meter Read

The new count of the meter if the read is an estimate. This evaluates to nothing for a ‘real’ 
read.

X

Project.Meter.Job.
Previous Job.Meter 
Read

This corresponds to the ‘Meter Read’ value for the same meter on the previous job of the 
same type for the machine when ordered by Date Due.

Project.Meter.Job.
Previous Job.Effective 
Meter Read

X

Project.Meter.Job.
Previous Job.Estimated 
Meter Read

X

Project.Meter.Job.Qty The total quantity billed for the particular meter including standard, unders and overs billing 
but excluding estimated amounts.

Project.Meter.Job.
Estimated Qty

The total quantity billed for the particular meter including standard, unders and overs billing 
only including estimated amounts.

X
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Macro Description Only v3.3 ?

Project.Meter.Job.
Pages

The total quantity billed for the particular meter including standard, unders and overs billing 
but excluding any estimated amounts. This evaluates to nothing for non-rate based meters.

Project.Meter.Job.
Effective Pages

The total quantity billed for the particular meter, regardless of whether it is an actual or 
estimated amount.

X

Project.Meter.Job.
Standard Qty

The standard quantity billed for the meter. X

Project.Meter.Job.Under 
Qty

The under quantity billed for the meter. X

Project.Meter.Job.Over 
Qty

The over quantity billed for the meter. X

Project.Meter.Job.
Purchased Prepaid 
Blocks

The number of prepaid blocks purchased. X

Project.Meter.Job.
Purchased Prepaid 
Pages

The total number of pages (blocks X block size) of prepaid pages purchased. X

Project.Meter.Job.
Previous Job.Prepaid 
Count

The number of prepaid pages available after the previous meter read. X

Project.Meter.Job.
Prepaid Count

The number of prepaid pages available after the current meter read. X

Project.Meter.Prepaid 
Block Size

The ‘Prepaid Bulk Pages’ as per the meter setup for a prepaid meter. X

Project.Meter.Job.Bill 
Date

This is the ‘next bill’ date when a machine is being billed. Exactly the same as ‘Project.Job.
Bill Date’. Kept separate for symmetry.

X

Project.Meter.Job.Date 
In

The date the meter read job was created. Exactly the same as ‘Project.Job.Date In’. X

Project.Meter.Job.Date 
Due

The date due of the meter read job. Exactly the same as ‘Project.Job.Date Due’. X

Project.Meter.Job.Read 
Date

When manually entering in a read this date corresponds to the ‘Date’ field in the ‘Billing 
Meter Read’ window. When a meter read job is generated via an MPS feed this date will 
contain a value if it is supplied as part of the feed. Exactly the same as ‘Project.Job.Read 
Date’.

X

Project.Meter.Job.
Previous Job.Bill Date

The bill date of the job the last time this meter was billed. May be different from ‘Project.
Job.Previous Job.Bill Date’ if the meter is billed at a different periodicity to the project.

X

Project.Meter.Job.
Previous Job.Date in

The date in of the job the last time this meter was billed. May be different from ‘Project.Job.
Previous Job.Date In’ if the meter is billed at a different periodicity to the project.

X

Project.Meter.Job.
Previous Job.Date Due

The date due of the job the last time this meter was billed. May be different from ‘Project.
Job.Previous Job.Date Due’ if the meter is billed at a different periodicity to the project.

X

Project.Meter.Job.
Previous Job.Date Out

The date out (effectively invoice date) the last time this meter was billed. May be different 
from ‘Project.Job.Previous Job.Date Out’ if the meter is billed at a different periodicity to 
the project.

X

Project.Meter.Job.
Previous Job.Read Date

The read date the last time this meter was billed. May be different from ‘Project.Job.
Previous Job.Read Date’ if the meter is billed at a different periodicity to the project.

X

Project.Meter.Job.Next 
Job.Bill Date

The ‘Next Bill’ date the next time this meter is due to be billed. This is calculated using the 
current ‘Date Due’, and either the periodicity of the meter or the periodicity of the project/
machine.

X

There are also a corresponding set of macros for a linked meter, if available. They can be formed by adding ‘.Linked Meter’ after the 
‘Meter’ part of the macro.

For example, the first macro becomes ‘Project.Meter.Linked Meter.Counter Name’ in order to get the name of the linked meter.

There is also some special handling of macros when it is for a meter billing kits. 



Jim2® Business Engine version 3.3 | Release Notes | Page 18  

Meter Kit Macro handling
Macro Description Only v3.3 ?

Project.Meter.Rate TF The sum of all ‘Rate Ex.’ for included stock where the stock relates to a ‘rate based meter 
type’, and it is not a third party PO meter.

Project.Meter.Rate TP The sum of all ‘Rate Inc.’ for included stock where the stock relates to a ‘rate based meter 
type’, and it is not a third party PO meter.

Project.Meter.Base TF The sum of all ‘Rate Ex.’ for included stock where the stock relates to a ‘Base Charge’ 
meter type.

X

Project.Meter.Base TP The sum of all ‘Rate Inc.’ for included stock where the stock relates to a ‘Base Charge’ 
meter type.

X

Project.Meter.Min TF The sum of all ‘Rate Ex.’ for included stock where the stock relates to a ‘Min Charge’ meter 
type.

X

Project.Meter.Min TP The sum of all ‘Rate Inc.’ for included stock where the stock relates to a ‘Min Charge’ 
meter type.

X

 
 
Date Macros

Each Date has a corresponding set of ‘Sub Macros’ attached to it. The first two are each themselves dates. They are:

•  Previous Month
•  Next Month

For each individual date macro (including Previous and Next Month) there are the following ‘Sub Macros’:

•  Day
•  Month
•  Year
•  LongDateFormat

For example, if the machine’s ‘Bill Date’ was the 30th May 2013, the following macros would evaluate as follows:

{{Project.Job.Bill Date}} 30/05/2013

{{Project.Job.Bill Date.Previous Month}} 30/04/2013

{{Project.Job.Bill Date.Month}} May

{{Project.Job.Bill Date.Next Month.LongDateFormat}} Sunday, 30th June, 2013

{{Project.Job.Bill Date.Next Month.Month}} June

Suggested macro
All of the above macros can be used in any combination to suit your specific needs. As a starting point, you may consider the following 
macro as it works nicely with estimates, and the ‘clawing back’ of estimates. The suggested macro for PO stock is very similar, except 
that it includes the additional information about the client (which would be redundant for meter billing stock) and serial number.

For meter billing stock

{{Project.Meter.Counter Name” “}}{{“Last Read - “Project.Meter.Job.Previous Job.Meter Read” “}}{{“Last Estimated Read - “Project.
Meter.Job.Previous Job.Estimated Meter Read” “}}{{Project.Meter.Job.Previous Job.Date Due” “}}{{“Current Read - “Project.Meter.Job.
Meter Read” “}}{{“Estimated Read - “Project.Meter.Job.Estimated Meter Read” “}}{{“Prints - “Project.Meter.Job.Qty” “}}{{“Estimated 
Prints - “Project.Meter.Job.Estimated Qty}}

For Third Party PO stock

{{Project.Card.Name” “}}{{“Serial No - “Project.Serial #” “}}{{Project.Meter.Counter Name” “}}{{“Last Read - “Project.Meter.Job.Previous 
Job.Meter Read” “}}{{“Last Estimated Read - “Project.Meter.Job.Previous Job.Estimated Meter Read” “}}{{Project.Meter.Job.Previous 
Job.Date Due” “}}{{“Current Read - “Project.Meter.Job.Meter Read” “}}{{“Estimated Read - “Project.Meter.Job.Estimated Meter Read” 
“}}{{“Prints - “Project.Meter.Job.Qty” “}}{{“Estimated Prints - “Project.Meter.Job.Estimated Qty}}
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Email > Email Templates

For existing Jim2 v3.2 customers you may have noticed that some settings in Tools > Options > Project > Machines and Tools > Options 
> CardFile have moved. The old fields for Page Request Text Emails, Web Emails, and Password Welcome emails are now Email 
Templates, rather than defined in Options. This allows much greater flexibility for sites with multiple branches.

If you are new to MPS in v3.3, you will need to create some email templates for sending out automated Page Requests.

Select the Email Tab and click on Email Templates. 

Select the Add button at the bottom of the Email Templates Window.

 
In the Template Name field choose a name for your email Template.

Choose a standard Subject field to go on all Page request emails. You can use the Context Field from the Editor Ribbon to choose the 
Page Request Context. You will need to scroll to the bottom of the list. 

Once selected, you can choose any of the available Page Request Contexts to personalise the email to the customer.

In this case we used the following Page Request Macros:

• {{Page Request.Request Due Date}} to show the Meter Reading Due Date.
• {{Page Request.Attn}} to Show the Contact’s name.
• {{Page Request.Counters}} to list the Meters that a reading is required for.
• {{System.Company}} from General Macros to show the Company Name.

A complete list is shown below:

 
Save the Email Template.

We can now specify that for all Page Requests of type ‘Text Email’ we would like to use this email template.
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Email > Editor Rules

Select the Email Tab and choose the Editor Rules button from the ribbon.

The existing Editor Rules are displayed showing our default email template (Happen Signature).

In the Templates by Source Section click in the Source Field and select ‘Email Page Count (Text Email) from the List Box. Select the 
Template you just created. Email Tags and Reply email are optional, but are useful to group all Page request emails in a single folder, or 
to dictate the Reply to address on all outgoing emails regardless of the sender.

 

If you have the Jim2 eMeter Reads option set up for customers to submit Meter readings via your website, then you can repeat this 
process for a Page Request Web Email Template, and an additional Editor rule for ‘Email Page Count (Web Email)’. 
 

You’re now ready to create your first v3.3 Machine.
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Machine Creation and Meter Setups

Machine Contract

Projects > Add Project

From the Projects Tab select the Add a Project button from the Ribbon. The Tab and buttons may be named differently if you have 
renamed Projects. Below is an example of a Typical Cost per Copy Contract.
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Field Purpose

Project# Auto Generated by Jim2. Can be edited. Can be Alphanumeric if entered manually.

Cust Ref A standing Order Number to place on Documents. Often used for Finance agreement numbers.

Billed The preferred Billing Frequency.

Last Bill The last Billing date. Automatically set by Jim2.

Next Bill If you select a Billing Frequency other than Manual, Jim2 will prompt you for the next Billing Date for this machine.

Ex. Proj# This Project can be linked to another Project, possibly a Project on Finished.

Groups Projects can be grouped for reporting purposes.

Item# The Item (Model) this Project is linked to. This determines related stock and available meters.

Make The Item Make. Set automatically once Item is selected.

Model The Item Model. Set automatically once Item is selected.

Cust# The Customer CardFile that all $0 Jobs are Invoiced to, and who any charges are typically billed to (excluding meter 
billing).

Ship# The Ship CardFile that Consumable Deliveries or Service Technicians are assigned to.

Contract The Contract Price Level for this Specific Contract. See the Price Levels created Earlier.

Cont. In The Contract Start Date.

Cont. Out The Contract End Date.

Avg Bills The Average Bill in $ for this Contract. Automatically Set by Jim2.

Desc. The Item Description Field. Set automatically once the Item is selected.

Master# The Master Contract to link this Machine to. 

Status The Status of this Contract.

Priority The Default Priority of all Jobs created under this contract.

Req Days The Default Date Due in days from the Job Booking Date for all Jobs created under this contract.

Hours The Default Date Due in hours from the Job Booking Date for all Jobs created under this contract.

Warr. In The Warranty Start Date.

Warr. Out The Warranty End Date.

Price Rev. The next date to review the Pricing on this Contract.

Comment Additional information about this Contract, often used to record options fitted or Finisher type.

Type The Project Type. As per the created Project Types earlier. This field determines the availability of the Meter Setup Tab at 
the bottom of the Project.

Individual 
Request

If a single contact is the Meter reading contact for a range of machines, this field determines whether they receive an 
individual Page Request per Contract or a Consolidated Request.

Request# The Request CardFile. This CardFile should contain the Meter Reading Request Contact.

Request by The Method that Meter readings are collected for this Contract. 

Location Once arriving at the delivery address listed on the Ship# CardFile, additional location information such as Library, CEO’s 
Office or Chemistry Lab Building 7, etc. Very useful for discerning which Contract a customer may be calling about if 
they have multiple machines.

Ship 
Address

The Delivery address for this machine. Set automatically by Jim2 from the Selected Ship# CardFile, but can be edited 
manually.

Serial# The Unique Serial# for the Machine.

Name If a particular Technician generally services this contract then he can be specified here.

Acc. Mgr The Account Manager who handles this contract, typically the original salesperson.

Attn: The Contact for this Contract for Meter Reading Page Requests.

Req to Set Automatically by Jim2 from the Request# CardFile and selected Attn. Contact.
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Standard Meter Setup

Provided the Project Type is selected as a valid Machine Type, then the Project will have a Meter Setup Tab at the bottom of the 
Project. Select the Meter Setup tab, and let’s create a Standard Meter Setup for a Colour MFD.
 

Meter Names are free type, however once you have entered a Meter Name it will appear in the Listbox. In this case Meter Types are 
just Standard Black and Colour. You will notice that in the Billing Stock Code Listbox only valid Billing Stock Codes can be selected. This 
means that on a Black Photocopier a Colour Billing code cannot be selected by mistake, or an Unders Billing code used in Standard 
Billing. Whether the Code appears or not in the Listbox depends on the Billing Code setup on the Project Tab of the Stock code set to 
Black Standard or not, which we worked through earlier.

As there are now a lot more data columns available we need to ignore the Unders and Overs Columns for now, and scroll right out to 
the right hand side to see the Service Meter setup and Current Meter Counts.

 
The last section of the Meter Setup line now shows the Current Meter count totals.  
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Opening Balances

Opening balances for machines and masters have become slightly more complicated for Jim2 v3.3 machines. As it is now common for 
a machine to have Standard, Unders and Overs billing, it is now necessary to be able set opening balances for each of these values. 

This is done by setting an opening balance for the stock assigned to the particular charge type. A typical photocopier would only have 
an opening balance set for the stock of its standard meter. 

As in the previous example, the meter setup of a colour photocopier machine is as follows:
 

The opening balance of the machine is set up on the opening balance tab:
 

This allows the black meter and black service meters to have independent opening balances. For these two meter types it has little 
practical impact, as service reads are always charged at $0.00, but it does become more important when unders and overs stock are 
assigned an opening balance.

Jim2 tracks average or estimated reads for v3.3 machines using under stock. This means that a simple cost per copy machine setup 
that allows averages may look similar to the following:
 

If this machine was being created in Jim2 for the first time, and had previously had a recorded read of 40,000 black pages, and a 
subsequent estimated read of 10,000 pages, you would set up its opening balance tab as follows:

 

The inclusion of a price for the unders is only required where either of the ‘historical’ rates of Clawback are used (ABH, OBH, AUH, OUH). 
If either of the ‘current’ methods of Clawback is used (ABC, OBC, AUC, OUC) then only the page count is required. If supplied, the 
read/purchase date indicates the last time a read was performed. The above grid shows an actual read was recorded on1st April, but 
an estimate was supplied the following month on 1st May 2013.

Multiple Counter Setups 

Even Machines with multiple counters are easy to set up. Let’s take a Machine that has both A4 and A3 Counters on it.

 
Some machines such as the Fuji Xerox ColourQube have similar setups.
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Unders/Overs Meter Setup 

Using our Simple Colour Meter setup from before we will now add in a Minimum Volume, Under and Over information into the Contract.
 

Again, Jim2 forces us to use only the correct Billing Codes for Unders and Overs, Black and Colour.

Set Unders Stock Code to the MC.BLACK.U and CardCode to Invoice to the relevant CardFile. As the CardCode to Invoice is stored 
separately for Standard, Unders and Overs Billing, they could in theory be to 3 separate CardFiles.

This is useful when billing Standard and Unders to a Funder, and Overs to the Customer. 

There are now additional Meter options to Hide on the Invoice. This is useful for Customising how the Customer or Funder sees the 
Invoice. As usual with the Hide option, it has 3 settings, and even though the customer may not see a Specific line on their Invoice, you 
would still see it on the Job. 

The Non Billable option will allow you to track meters charged by 3rd Parties. Jim2 will Discount the charge 100% on the Invoice, and 
again it could be hidden so you can monitor where a Contract is up to.

Set a Minimum for the Black and Colour Meters in the Minimum Volume. In this example, the Black meter has a Monthly minimum of 
2000 copies, and 350 Colour copies. If the Meter reading falls below the Minimum, Jim2 will Invoice the Unders Stock Code to the 
specified CardFile for the Uplift. In addition, you can specify Overs Billing Stock Code, CardFile to Invoice, and Hide/Non Billable 
options, as well as rate. In this case, Overs will be billed at the same rate as the Standard Meter.

Setting a Minimum up in this way forces the amount of copies to be enforced, rather than a Flat Rate. That way Rate Variations do 
not affect the amount of copies the customer is contracted to do, as it will always be 200 Black and 350 Colour. Jim2 would prompt 
us on saving that there are new Opening Balances to be added for the Unders and Overs, and they would be set to Zero’s unless the 
machine is being added mid cycle. 

New Meter Types and Options

Jim2 v3.3 introduces a number of new meter types, and adds additional functionality and flexibility to existing meter types.

Meter Type Description Is New in v3.3 ?

Black Tracks black pages. Supports standard/unders/overs billing.

Colour Tracks colour pages. Supports standard/unders/overs billing.

Total (Linked) Tracks colour pages by calculating the total number of pages and subtracting the 
number of black pages. Supports standard/unders/overs billing.

Scan Tracks scans. Supports standard/unders/overs billing. X

Prepaid Pages Allows pages or scans that are used to be paid for by prepaid pages. Also allows for 
prepaid pages to be bought in fixed ‘bundles’. Prepaid meters are different from other 
meters in that prepaid meters are always trying to reach 0 (as opposed to other meters 
which try to catch up to the unlinked meter).

Base Charge Applies a fixed dollar amount charge.

Min Charge Ensures the specified client is charged a minimum amount. This minimum amount 
excludes any base charges. This is different to Jim2 v3.2 where the Min Charge included 
any base charges. Amounts billed to other card files are ignored when calculating if the 
minimum charge applies.

Total Black (Calculated) Virtual meter that is calculated using the totals of all black meters. Supports standard/
unders/overs billing. Uses A4 Ratio to give a weighting to each meter that makes up the 
total.

X

Total Colour 
(Calculated) 

Virtual meter that is calculated using the totals of all colour meters. Supports standard/
unders/overs billing. Uses A4 Ratio to give a weighting to each meter that makes up the 
total.

X

Total (Calculated) Virtual meter that is calculated using the totals of all meters. Supports standard/unders/
overs billing. Uses A4 Ratio to give a weighting to each meter that makes up the total.

X

Third Party PO Used to raise purchase order for costs associated with machine. Supports standard/
unders/overs billing.

Third Party PO Base Used to raise purchase order for base charges associated with machine. X

Third Party PO Min Used to raise purchase order for minimum charges associated with machine. This 
minimum amount excludes any PO base charges. PO lines created for other vendors are 
ignored when calculating if the minimum PO charge applies.

X

Balancing This meter is used to balance to a specified fixed dollar amount. Balancing stock 
removes any difference between a calculated amount, and a specified dollar amount. 
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Meter Setup Fields

Section Field Name Description

Meter ID The ID of the meter. This value is the same for linked black, colour and scan meters. 

Meter 
Name

A unique name for this meter. This name is used in linking an MPS feed to a Jim2 meter.

Meter Type The type of the meter. See previous section for descriptions of the various types. A colour meter is only 
available to items that are specified as colour. A black meter is only available to items that are either 
black or colour. See Items setup for further details.

Current 
Meter 
Count

This is the current meter count. It is the sum of the current count for the standard billing stock code 
and the overs billing stock code on ‘Ready’ or invoiced jobs, minus any strict returns from customer of 
invoiced amounts.

Standard 
Billing 
Information

Billing Stock 
Code

This is the billing stock code that may be used for a job charge or for a PO line. This stock must be ‘non-
depleting’ or ‘journal’ for all meter types except ‘Prepaid Pages’, and ‘Balancing’ which must have a 
‘journal’ stock type.

Card Code 
To Invoice

The card code to bill standard charges to (or the vendor to create a PO line for).

Rate Ex. The rate, excluding tax, that standard and under charges will be calculated at.

Rate Inc. The rate, including tax, that standard and under charges will be calculated at.

Hide On 
Invoice

Checked means the entire line will not appear on the invoice. If this check box is greyed, pricing 
information will not appear on the invoice. If this check box is unchecked then the entire stock 
information and pricing details will appear on the invoice, except where the stock is kitted (see kits).

Child Hide 
On Invoice

This field is only available for master contracts. This field has exactly the same meaning as ‘Hide On 
Invoice’ except that this is the value that will be copied to child machines. This allows for a master to 
have a different value than its child machines.

Non Billable Specifies that the charge will be discounted at 100% on the job.

Unders 
Billing 
Information

Unders 
Stock Code

This is the billing stock code that may be used for a job charge, or for a PO line if an under charge is 
applicable. This can be specified for any meter type that supports standard/unders/overs billing (see 
meter types). The stock type specified must be journal stock.

Unders Card 
To Invoice

The card code to bill unders charges to (or the vendor to create a PO line for).

Hide Inv 
Under

Specifies whether unders charges are visible on the job. See ‘Hide on Invoice’.

Child Hide 
Inv Under

Specifies whether unders charges are visible for child machines. See ‘Child Hide On Invoice’. This is only 
available for master contracts.

Un Non 
Billable

Specifies that the unders charge will be discounted at 100% on the job.

Clawbk 
Unders

Specifies the method that is used when clawing back unders and overs (see Clawing back unders and 
overs). It is one of 9 options. That is, either Clawback is not available or it is one of eight other options. 
These eight options are made up of three separate options, each of which has two choices (2 * 2 * 2 = 
8). Each choice is designated by a single letter. They are:
1. A or O – indicates that All unders/overs, or only Open unders/overs can be clawed back.
2. B or U – indicates that Both unders and overs can be clawed back, or just Unders can be clawed 

back.
3. Indicates that unders/overs are clawed back at either the Current rate, or at the Historical rate, i.e. 

the rate which they were originally charged at.

For completeness, all 9 options are listed below:

• Blank – Unders will not be clawed back for this meter.
• ABC – All unders and overs are clawed back at the current rate. Only page count is important.
• ABH – All unders and overs are clawed back at the historical rate. In other words the rate at which 

they were charged at the time. The page count and rate are both important in this instance.
• OBC – Only open unders and overs are clawed back at the current rate. Whether unders are open 

is controlled by the ‘Leave Unders Available for Clawback’ stock that is set up in options.
• OBH – Only open unders and overs are clawed back at the historical rate. Whether unders are 

open is controlled in exactly the same way as for OBC. The unders are clawed back at the rate 
they were originally charged at.

• AUC – All unders are clawed back at the current rate. Only page count is important.
• AUH – All unders are clawed back at the historical rate. In other words the rate at which they were 

charged at the time. The page count and rate are both important in this instance.
• OUC – Only open unders are clawed back at the current rate. Whether unders are open is 

controlled in exactly the same way as for OBC.
• OUH – Only open unders are clawed back at the historical rate. Whether unders are open is 

controlled in exactly the same way as for OBC. The unders are clawed back at the rate they were 
originally charged at.

Minimum 
Volume

Optionally specifies the minimum volume for the meter. If the volume is not reached, and there is 
under stock specified the shortfall is charged as unders. If the volume is exceeded, any pages over 
the minimum volume are charged as overs. The minimum volume can either be specified for a single 
machine or it can be specified at the master contract level.
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Section Field Name Description

Overs Billing 
Information

Overs Stock 
Code

This is the billing code that may be used for any over job charges or PO lines. This stock type must be 
journal stock. 

Card Code 
To Invoice

The card code to bill over charges to (or the vendor to PO line for).

Overs Rate 
Ex. 

The rate, excluding tax that over charges will be calculated at.

Overs Rate 
Inc.

The rate, including tax that over charges will be calculated at.

Hide Inv 
Over

Specifies whether over charges are visible on the job. See ‘Hide on Invoice’.

Child Hide 
Inv Over

Specifies whether over charges are visible for child machines. See ‘Child Hide On Invoice’. This is only 
available for master contracts.

Ov Non 
Billable

Specifies that the overs charge will be discounted at 100% on the job.

Linked 
Meter

If the meter type is black, colour, scan or 3rd party PO meter, this specifies the unlinked (or main) meter 
that it should balance to. If this value is empty, the meter is classed as an ‘unlinked meter’, and requires 
a meter read to be directly applied to it.

If the meter type is ‘Total (Linked)’, this field links to the black meter that needs to be deducted from the 
total page count in order to calculate the colour page count. This is common with Canon meters to be 
supplied a black page count, and a total page count. In order to determine the Colour page count the 
black page count needs to be deducted from the total.

If this is a Prepaid meter type, the linked meter indicates which meter to apply the prepaid count 
against.

If the linked meter is specified (optional) for a Min Charge or a Third Party PO Min, it limits the minimum 
charge calculation only to those meters directly linked to the unlinked (or main) meter. For example, 
if machine has a black finance rate meter (unlinked), and a black service rate meter (linked to black 
finance meter), and a colour meter you can specify a minimum charge, and link it to the black finance 
meter. Only the charges on the black finance and black service meters would be included when 
determining if the minimum should be charged.

Start Date If specified, this meter will be excluded if the ‘Next Bill’ date is prior to the meter’s ‘Start Date’. Unlinked 
meters cannot have a start date specified.

If a ‘Billed’ frequency is also specified, once the meter has been successfully billed the start date is 
advanced by the frequency. For example, if the ‘Billed’ frequency is quarterly, and the start date is the 
‘1/01/2013’, once the meter has been billed the ‘Start Date’ is moved forward to ‘1/04/2013’.

End Date If specified, this meter will be excluded if the ‘Next Bill’ date is after the meter’s ‘End Date’. Unlinked 
meters cannot have an end date specified.

Billed If a ‘Billed’ frequency is specified, a start date must also be specified (the opposite is not true – you can 
specify a start date with no ‘Billed’ frequency). When a machine is billed after this date the ‘Start Date’ 
on the meter is advanced by the ‘Billed’ frequency.

Last Billed By Informational. The initials of the last user to bill the machine/project.

Service 
Reads

Service 
Stock Code

The stock code used to track service reads.

Hide Service Specifies whether the service read is visible on the job. See ‘Hide on Invoice’.

Toner Setup Toner 
Surplus

Information for reporting only.

Toner 
Cartridges

Information for reporting only.

A4 Ratio Used when calculating a ‘Total Black (Calculated)’, ‘Total Colour (Calculated)’ or ‘Total Calculated’ 
meter. This allows an A3 meter to be given a heavier weighting, such as 1.5 or 2 pages when compared 
to an A4 page.

Prepaid Prepaid Bulk 
Pages

Optionally specified for prepaid meters. This indicates the ‘number of page’ lots that prepaid pages are 
sold in. For example, if this value is 20,000 then prepaid pages are purchased in lots of 20,000.

Expires 
Frequency

Optionally specified for prepaid meters. This indicates the period of time after the prepaid pages are 
purchased that they expire. The date is calculated from the date due on the job where the prepaid 
pages were purchased.
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Prepaid Pages 

Prepaid pages can either be allocated to a particular machine or contract until they’re all used, or be bought in blocks on an ongoing 
basis. A prepaid pages meter will always be linked to either a black, colour or scan meter. With v3.2 style machines the ‘Prepaid Pages’ 
counter is always ahead of its corresponding linked meter. With v3.3 style machines this changes to the meter is always trying to use up 
any outstanding pages.

 

The stock COUNTER.JOURNAL.P must be journal stock, as the amount of ‘stock’ on hand is increased when a prepaid block is 
purchased, and subsequently reduced as the stock is used. In this particular case, there are 5000 prepaid pages remaining for this 
machine. If the client uses 17,000 pages then this will require two additional blocks of pages to be purchased (2 * 10,000 + 5,000 = 
25,000 pages). The created job would look like the following:

April 2013 – 17,000 pages
 COUNTER.BLACK 17,000 @ 0.01  = $170
 COUNTER.JOURNAL.P  20,000 @ 0.01  =   $200
 COUNTER.JOURNAL.P -17,000 @ 0.01  =  -$170

If the ‘Prepaid Pages’ meter is set up with an ‘Expires Frequency’, then it must also be set up with under stock. This ‘under stock’ actually 
refers to the stock that is used to offset the expired pages.

April 2013 – 11,000 pages – Pages Expire after 1 month
 COUNTER.BLACK 11,000 @ 0.01  = $110
 COUNTER.JOURNAL.P  20,000 @ 0.01  =   $200
 COUNTER.JOURNAL.P -11,000 @ 0.01  =  -$110
 
May 2013 – 4,000 pages 
 COUNTER.BLACK 4,000 @ 0.01  =  $40
 COUNTER.JOURNAL.P -4,000 @ 0.01  =  -$40

June 2013 – 9,000 pages
 COUNTER.BLACK 9,000 @ 0.01  =  $90
 COUNTER.JOURNAL.P  -5,000 @ 0.01  =  -$50
 COUNTER.EXPIRED.P   5,000 @ 0.01  =   $50 (This expired stock offsets the ‘used’ prepaid stock)
 COUNTER.JOURNAL.P 10,000 @ 0.01  =   $100 (Purchase another block)
 COUNTER.JOURNAL.P  -9,000 @ 0.01 =  -$90 

Because of fundamental differences between how v3.2 and v3.3 prepaid meters work, it is not possible to upgrade a v3.2 machine 
with a prepaid meter to a v3.3 style machine.

‘Prepaid stock’ can also be used to allocate a certain number of ‘Free’ pages to a machine or a contract. It can be set up so that 
once these ‘Free’ pages are used the machine or contract reverts to being billed as normal. See the example scenario section for 
more details.
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Master Machine Creation and Meter Setups

Master/Child relationships

The MPS edition in version v3.2 supported Master Child relationships, but in a very limited way. In Version 3.3 we have made substantial 
improvements to the way Masters and Children work together to provide not only easier setup of large contracts from scratch, but also 
simpler management of existing contracts.

Let’s start by creating a new Master type Contract. 

Tools > Setups > Project > Project Types

Create a Project type named Master, using the new Master Machine System Type.

 

Items > Add Item

We will be creating a Master Contract, and we will need to link the Contract to an Item. As the Master Contract could be for a range 
of different machine models, we need to add an additional Item for the Master Contract. In the Items tab select the Add Item button 
and add a new Master MPS Item as per below example. 
 

This Item setup differs from previous specific model examples in that ‘Display Serial #’ and ‘Serial # is required’ are deselected. As the 
Master MPS contract may reflect a range of machines, it does not need to be serialised.

Also, we will more than likely use this Item for many different MPS contracts which may contain Black and/or Colour Photocopiers, so for 
the Master Item we will set the Photocopier Type to Colour so that the contract can reflect both types.
 

Tools > Setups > CardFiles > Price Levels

Now we need to add a new Contract Price Level for our MPS contract. In the Tools tab, select the Setups button and in 
CardFiles > Price Levels add a new price Level for MPS Contracts.



Jim2® Business Engine version 3.3 | Release Notes | Page 30  

Projects > Add Project

From the Projects tab, select the Add Project button. Enter all fields as per previous machine setup example. Note that the Type on this 
Project is the ‘Master’ type, and the Item is the Master Item, both of which we created earlier.

 

Master Machine Meter Setup

Select the Meter Setup tab at the bottom of the Project. We will now create a Master Meter setup that will apply to all Child Machines. 
The initial columns are very similar to our previous meter setup. Note that Jim2 now displays in Column 1 a Master Meter tickbox. This 
determines whether Jim2 should copy this meter setup down to all Child Machines or not. In most cases this is required, however if your 
Child machines have different rates, this tickbox may need to be deselected. In this example we will select the tickbox for Master Meter 
for both Black and Colour.
 

 

Now we enter our Unders/Overs billing information on the Meter setup line of the Master contract, including our Minimum Volume that 
is specified for all child machines of the contract. This is the total for all machines on the contract, and in this example the customer is 
contractually bound to 10,000 black pages, and 2500 colour pages each month.
 

 
Finally, we enter our remaining meter setup columns for service stock reads as per previous examples.

 
Save the Project and you will be presented with the following dialog:

 
If selected, Jim2 will copy the selected field’s value from the Master Contract to the Child Contract. At this stage we do not have any 
Child contracts to copy down to, so we will just click ok, and save the Master.
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Create a Child machine for each Machine that is part of the Contract. Concentrate on filling in values on the Child machine that are 
required/unique such as Cust#, Project Type, Item, Serial Number. As seen in the previous screenshot, the Master can copy down fields 
such as Contract Type, Contract Start/End, Warranty Start/End and Request fields. In the Master# field enter the Project# of the Master 
Contract. You can link back to the Master Contract by selecting the Hyperlink next to the Master# field.

Select the Edit button and immediately select Save, and you will again be presented with ‘Copy fields to Child Project’ dialog – select 
the Fields you would like to copy down to the Child Machine.
 
If you now view your Child Machine, you will see all the selected fields have copied down to the Child, including the meters.

Aside from the fact that this makes it much easier to set up a Master with many children linked to it, we can now be confident that 
the Machines under the Master Contract are all set up in the same way. Additionally, the Master is now the dominant record of 
all Children’s Meter setups, so any rate changes will be copied down to all children when the master is edited and saved, making 
variations much easier to administer.
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Split Meter Setups

Let’s look at a situation where the Customer has been quoted a figure for Black and Colour, and that includes both a Service and 
Finance/Rental Component.

In this case, we would like Service and Finance Split so they report to separate GL Accounts, but from the customer’s perspective they 
should only be Billed a Single Amount – this machine bills the client a service component and a finance component. Internally you 
want to keep track of the income split, but you want to bill the client a single combined amount. This assumes you have kitting enabled 
in options (Tools > Options > Project > Machines > Linked Meter Kit Stockcode.
 

Choose a descriptive Meter Name to Highlight the Split. The rest of the Meter line is set up as per the Unders/Overs example. Meter ID 2 
needs to be linked to Meter ID 1 using the Linked Meter Column, as per below. Once Linked, Jim2 will change the Meter ID’s both to 1 
showing that they are linked. 

 
Once the meter line is entered as above and saved, Jim2 adds the Total line showing the overall figure of 1 cent per Black copy. 

Both meters have independent opening balances. In this case you need to ensure they are the same. Jim2 will by default give you a 
chance to enter in the ‘primary’ black meter, and then automatically populate the value of the finance meter to be the same as the 
current meter count of the black meter. 

 

Also note that the minimum volume is specified for each meter. Jim2 allows these to operate independently, if required.

If we receive a meter read of 53,500 for black, the following job is produced:

 
Here, the client sees that it has been billed the minimum of 5,000 pages at $0.01 per page. Internally for accounting purposes, we have 
a split between standard billing and unders, as well as a split between service and finance charges.
 
If the following month we receive a read of 61,000 this job is produced:
 

This overs job again contains the split between service and finance, as well as standard and overs billing. The client again is presented 
with an invoice that contains the total number of pages, and the combined rate.
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Print Management Plan Meter Setups

More complex Meter setups are required for Print Management Plans. As an example, we will now set up a Master contract that Bills 
all Standard and Unders Billing to a Finance Company on a monthly basis, and those charges are split between Service and Finance 
40/60, however the overs for the Contract are all billed directly to the customer, and are billed on a quarterly basis. Set up your Master 
Meters as detailed below. 

The Standard Billing is set up as follows. Note that in this case we have 3 meter lines for Black and 3 for Colour, which are totalled by 
Jim2 for us. The Service and Finance components are split 40/60, and are billed to the Finance Company or Funder’s CardFile. The 
over lines are billed to the Customer CardFile. As the customer has been billed the standard billing by the Finance company already, 
we zero out the standard billing for the Customer Meter line. Also, Jim2 requires a unique Billing Stock Code for each meter line, 
so in this case we require additional Billing Stock codes be set up for MC.BLACK.2, MC.BLACK.2.U, MC.BLACK.2.O, MC.COLOUR.2, 
MC.COLOUR.2.U, MC.COLOUR.2.O.

 
Next, we configure the Unders/Overs Meter lines. In this section of the meter setup, we zero out the rates for overs on the Finance 
company meter lines, as they are not charges for any overs in this case. As there is no split on overs in this case, the full 1 cent/10 cent 
rates are billed to the customer. Jim2 will display the Overs on the Finance invoices even though they are charged at $0, so we will 
utilise the Hide Inv Ovr and Child Hide Inv Ovr so that the Finance company jobs contain the overs data, but it is hidden on their invoice 
and not visible to them. Note that the Finance and Over meter lines are linked to their respective Service Meter lines using the Linked 
Meter column.
 

Finally, we configure the remaining meter columns. For the Overs lines for both Black and Colour we set the Start date to the next bill 
date for the Overs, and set the Billed column to Quarterly. This means Standard and Unders Meters are billed monthly to the Finance 
Company, and the Overs are billed to the Customer Quarterly. 
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Clawback Meters 

Jim2 v3.3 offers the ability for meters to ‘claw back unders and overs’ that have been previously charged.

For example, a machine is charged a minimum black volume of 1,000 pages per month.

Month 1 – a page count of 800 is recorded. 800 pages are charged as standard billing, and 200 pages are charged as unders to make 
up the minimum volume of 1,000 pages.

Month 2 – a page count of 1,100 is recorded. 1,000 pages are charged as standard billing, and 100 pages are charged as over pages.

If we consider the two months together then 1,900 pages were used. 100 unders pages should have been charged to make up the 
minimum volume of 2,000 pages for the 2 months. To achieve this, ‘Month 2’ needs to claw back 100 unders pages from ‘Month 1’ to 
offset the 100 overs charged in ‘Month 2’.

Overall this means that the following was billed.

Month 1: 800 standard pages  
 200 under pages

Month 2: 1000 standard pages
 100 over pages
 -100 under pages This is the Clawback of unders. When we reduce unders we 
 -100 over pages  reduce overs as well and standard pages are increased by the
 +100  standard pages same amount.

Unders are made available in one of two ways:

1. The meter has ‘Clawback Unders’ set to one of the following options. All ‘unused’ unders are available without restriction.

a. ABC (All, Both overs and unders at Current rate)
b. ABH (All, Both overs and unders at Historical rate)
c. AUC (All, Unders only at Current rate) 
d. AUH (All, Unders only at Historical rate)

2. The meter has ‘Clawback Unders’ set to one of the following options. Previous billing jobs for this machine/master have ’leave 
unders open’ stock on them. Unders for a particular meter can be clawed back from previous jobs as long as the ’leave unders 
open’ stock is found. As soon a job is found without the ’leave unders open’ stock on it, any unders that were charged prior to this 
are no longer available. 

a. OBC (Open, Both overs and unders at Current rate)
b. OBH (Open, Both unders at Historical rate) 
c. OUC (Open, Unders only and unders at Current rate)
d. OUH (Open, Unders only at Historical rate)
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Clawback Unders example

For example, a machine with a minimum of 1,000 black pages per month, and Clawback Unders is set to OBC (Open, Both overs and 
unders at Current rate).

January 2013 – 800 pages
 MC.BLACK 800 @ 0.01 = $8.00
 MC.BLACK.U 200 @ 0.01 = $2.00
 LEAVE.UNDERS.OPEN 1 @ 0.00 = $0.00

February 2013 – 700 pages
 MC.BLACK 700 @ 0.01 = $7.00
 MC.BLACK.U 300 @ 0.01 = $3.00

March 2013 – 600 pages
 MC.BLACK 600 @ 0.01 = $6.00
 MC.BLACK.U 400 @ 0.01 = $4.00
 LEAVE.UNDERS.OPEN 1 @ 0.00 = $0.00

April 2013 – 1,600 pages
 MC. BLACK 1000 @ 0.01 = $10.00
 MC.BLACK.O 600 @ 0.01 = $6.00
 MC.BLACK 400 @ 0.01 = $4.00
 MC.BLACK.U -400 @ 0.01 = -$4.00
 MC.BLACK.O -400 @ 0.01 = -$4.00

When overs are charged in April we can only claw back the 400 under pages that were charged in March. The 300 under pages 
charged in February, and the 200 unders pages charged in January are unavailable because February doesn’t have LEAVE.UNDERS.
OPEN stock on it.

If we take March and April together we have 2,200 pages, consisting of 2,000 MC.BLACK (600 + 1000 + 400), and 200 MC.BLACK.O (600 
– 400). The unders from March are clawed back, and removed in April (400 – 400).

If the meter had Clawback Unders set to ABC or ABH then all the unders would be available for claw back, regardless of the LEAVE.
UNDERS.OPEN stock, and the April billing would be changed to:

April 2013 – 1,600 pages
 MC.BLACK 1000 @ 0.01 = $10.00
 MC.BLACK.O 600 @ 0.01 = $6.00
 MC.BLACK 600 @ 0.01 = $6.00
 MC.BLACK.U -600 @ 0.01 = -$6.00
 MC.BLACK.O -600 @ 0.01 = -$6.00
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Clawback Unders and Overs example

Clawback unders not only refers to clawing back unders, but also clawing back of overs in the same manner. For example, a machine 
with a clawback type set to OBC would bill in the following manner:

January 2013 – 1200 pages
 MC.BLACK 1000 @ 0.01 = $10.00
 MC.BLACK.O 200 @ 0.01 = $2.00
 LEAVE.UNDERS.OPEN 1 @ 0.00 = $0.00

February 2013 – 1300 pages
 MC.BLACK 1000 @ 0.01 = $10.00
 MC.BLACK.O 300 @ 0.01 = $3.00

March 2013 – 1400 pages
 MC.BLACK 1000 @ 0.01 = $10.00
 MC.BLACK.O 400 @ 0.01 = $4.00
 LEAVE.UNDERS.OPEN 1 @ 0.00 = $0.00

April 2013 – 400 pages
 MC.BLACK 400 @ 0.01 = $4.00
 MC.BLACK.U 600 @ 0.01  = $6.00

 MC.BLACK 400 @ 0.01  =  $4.00
 MC.BLACK.U -400 @ 0.01  =  -$4.00
 MC.BLACK.O -400 @ 0.01  =  -$4.00

The last 3 entries are clawing back the 400 overs that were charged in March 2013. The overs from January and February are again 
unavailable due to the fact that February didn’t have LEAVE.UNDERS.OPEN stock on it. If we consider the last two months together we 
have a page count of:

MC.BLACK  = 1000 + 400 + 400  =  1800 pages
MC.BLACK.U  = 400 + 600 – 400  =  200 pages
MC.BLACK.O  = 400 – 400  =  0 pages

Notice that the amount billed for April in this situation is $6, which is less than the minimum charge. This is because Jim2 is adjusting for 
the client paying ‘too much’ in a previous month.

A machine with a Clawback type set to ABC would bill in the following manner:

April 2013 – 1,600 pages
 MC.BLACK 1000 @ 0.01  =  $10.00
 MC.BLACK.O 600 @ 0.01  =  $6.00

 MC.BLACK 600 @ 0.01  =  $6.00
 MC.BLACK.U -600 @ 0.01  =  -$6.00
 MC.BLACK.O -600 @ 0.01  =  -$6.00

When entering in a meter read for a machine, or generating a master billing job, the unders or overs count for each meter that is 
available for claw back are displayed in the grid.

If the Clawback type is set to only claw back open unders (OUC) then the above example will change to the following:

April 2013 – 400 pages
 MC.PAGE.BLACK 400 @ 0.01  =  $4.00
 MC.BLACK.UNDER 600 @ 0.01  =  $6.00

Notice that we don’t attempt to claw back the overs charged in March. Also note that the client is still billed the minimum volume in 
April.
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Meter Billing Engine changes

New Meter Reading Options – Averages, Estimates

In earlier versions of Jim2 billing average readings, when the customer failed to provide a reading it was problematic in that the 
reading could only be entered into Jim2 as an actual reading. If the reading was conservative then it didn’t generally present a 
problem as subsequent readings were always higher, but if the average billed was higher than the subsequent reading, then there 
were a number of steps required to credit the average, and re-enter the actual reading, because Jim2 does not allow an actual 
reading lower than the previous reading. 

In order to cater to this need, and also to reduce the administration required, we have introduced a new way of entering averages or 
estimates. This new method allows an average or estimate to be billed, and later when the real reading is received Jim2 reconciles the 
new reading automatically. To do this we will use an ESTIMATE Stock code to indicate to the customer on their Invoice that we have 
billed an estimated reading. We will also need to utilise the unders meter. 

In order to set the database up to handle averages/estimates we need to configure a global setting and create several stock codes, if 
they do not already exist.

Stock > Add Stock

Create a Non Depleting Stock Code for Billing Estimates, as per the example below:

 
This stock code does not need any meter type set in the machines tab as it will be displayed on Estimated reading jobs for the 
customer’s information only.

Add an unders stock code for black and colour, as per the example below. This will be the Billing code used for the estimated reading. 
If this code already exists then just use the existing code.

 
In the Projects tab set the Meter type to Black or Colour as appropriate, and the Billing type to Unders.

In the Macro Desc. field construct a macro as per below example. This macro will display either the Last read, or last estimated read 
and the current read, or current estimated read to the customer. By placing the text ‘Last Read –’ inside the Curly brackets we tell Jim2 
to only display the text if the Macro returns a value.
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Tools-Options > Project > Machine

Now we need to enable the Estimate Code we created in the Project Options.

 
Meter Setup – Note the addition of the Unders Billing information.

 
If we now select the add meter button at the bottom of the machine we have additional options at the bottom of the meter entry 
screen to enter an average.

 
Instead of an average, we can also choose to enter an estimate, in which case we can nominate a meter reading from past 
experience with this customer. If we select an estimate Jim2 will offer to default to the average reading if we prefer.
 



Jim2® Business Engine version 3.3 | Release Notes | Page 39  

For this example we will enter an estimate of 55,000 Black copies and 11,500 Colour Copies.

Jim2 will create a billing job similar to the following:

 
The Customer’s Invoice shows the reading is an estimate as per the terms and conditions of the agreement. In a later billing cycle the 
estimate will be reversed, and an actual reading recorded. To keep it simpler for the customer to read we hide the contents of the 
reconciliation from them.

 
See Scenario 2 for a complete step by step example.

New Meter Reading Options – No Read

We have added a ‘No Read’ option to the Meter Entry screen which allows billing of a contract, in particular a master contract where 
readings have not been received for the machines, but we still need to bill the minimum charges. 

First, we need to create a Non Depleting Stock code to be used on Billing Jobs where no read was received. This is a simple Stock 
Code similar to our previous estimates example, and needs no meter setups in the Projects tab.

Stock > Add Stock
 

 
Next we enable the No Read option in our Project Options.
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Tools > Options > Project > Machines

 
For the purposes of this example, we have a Master Contract with a single child. The Minimum Volume on this contract is 10,000 Black 
and 2,500 Colour per month. 

This month we have no reading for the child, and we wish to bill the Master and Child for the Minimum Volumes, as per the contract.

Select the Master Contract, and click the Add Meter button then add a Billing Meter. At the bottom of the Meter Read Entry dialog 
select the drop down and choose ‘No Read’.

 
We can see that the Child meter reading is missing when we bill the Master. After selecting Read type as No Read, we are prompted 
with the Dialog above asking if we want to proceed in billing the Master and Child without a reading. Select Yes.

Jim2 will now create 2 Billing jobs, one for the Child and one for the Master Contracts.

Child Machine Billing Job

 
The NO.READ stock code present on billing job identifies this machine as having been billed with No Reading.

Master Machine Billing Job
 

Jim2 will bill the Minimums as Unders against the Master Machine Contract, ensuring that the Customer or Funder is billed the Minimums 
each month, regardless of the customer providing a meter reading for the machine.
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Meter Billing Reports – InvoiceMeters

A range of Invoice layouts (reports) are available. Let’s start with the simplest (InvoiceMeters).
 

This report would typically be the default Invoice report for all Meter Billing Invoices. This can be set in Options.

Tools > Options > Job > Invoice
 

 

In some cases, a particular customer might want a slightly different Invoice. Previously in Jim2 3.2 you would create a different Invoice 
Layout for that customer, and then manually invoice them each month, before batching the rest of the Meter Billing. However, now 
you can set a customer CardFile to use a specific Invoice Layout for Meter Billing. Select the CardFile you wish to have a different 
default Invoice report and edit the CardFile, then select the reports tab at the bottom of the screen.

CardFiles > View/Edit CardFile
 

Where a customer may have multiple Meter Billing Jobs due to having more than one machine, the default behaviour in Jim2 is to 
group those jobs onto a single invoice when batching the jobs together. 
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Jobs > Create Job List

Select only the Ready Tickbox on the right of the screen, and select Type MPS Billing then choose your customer.

 
If we select the Invoice Button from the ribbon and select our InvoiceMeters report, we should get something similar to the following: 
 

 

Meter Billing Reports – InvoiceMeters Master, InvoiceMeters Master Detailed

When dealing with Master Child Contracts, the Invoice may have more specific requirements. If a Master Contract is used then we 
have available several other  Invoice layouts.

InvoiceMeters – Master 

This Invoice layout shows only the summary of the Contract, showing the Minimum and Billed Volumes, and any Unders or Overs, if there 
are any. 

 
For a lot of customers this will be sufficient, and they may only require more if they feel there has been an error. 
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InvoiceMeters – Master Detailed

For those customers who wish to see how this Total is calculated, you may need to provide a copy of the InvoiceMeters – Master 
Detailed report. For the sake of space the entire report is not shown here.
 

 
In all cases now, the preferred layout can be set on the CardFile of the Customer, if it differs from the default.

Each Machine can have a different Invoice Description to the Default in Tools > Options > Project > Machine.

At a machine level you will find this setting moved to the Default Stock Tab of the Machine.
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Advanced Topics

Standard Meter Scenarios 

Scenario Name
1 Basic Cost per Copy

2 Basic Cost per copy with Estimates

3 Cost per copy machine with a minimum dollar amount

4 Cost per copy machine with a minimum dollar amount for black only

5 Cost per copy machine with a minimum volume for black

6 Cost per copy machine with a base charge

7 Cost per copy machine with a base charge and minimum

8 Cost per copy machine with a black A3 and black A4 meter

9 Cost per copy machine with a black A3 and black A4 meter with a minimum volume over the two meters

10 Cost Per Copy Machine Serviced By Third Party

11 Cost per Copy Machine Serviced by Third Party with a Minimum Volume Charge

12 Cost per Copy Machine Serviced by Third Party with a Minimum Charge

13 Cost per Copy Machine Serviced by Third Party with a Base Charge

14 Cost per Copy Machine Billing Exact Amount Using a Balancing Meter

15 Service and Finance Split and Billed as a Single Amount

16 Copy per Copy Machine Billed Using Prepaid Blocks

17 Copy per Copy Machine Billed Using Expiring Prepaid Blocks

18 Cost Per Copy Machine Skip billing

19 Cost Per Copy Machine with ‘Total’ meter

20 Master Contract with Multiple Child Machines

21 Master Contract with Multiple Child Machines, Some with Different Black Rate

22 Maser Contract with Multiple Child Machines and Minimum Volume

23 Master Contract with Multiple Black Machines with A3 & A4 meter and Minimum Volume

24 Master Contract with clawback of all unders and overs at current rate

25 Master Contract with clawback of all unders at current rate

26 Master Contract with clawback of all unders and overs at historical rate

27 Master Contract with clawback of all unders at historical rate

28 Master Contract with clawback of open unders and overs at current rate

29 Master Contract with clawback of open unders at current rate

30 Master Contract with meters with different periodicities

31 Master Contract with average billing

32 Master Contract or Standalone with Prepaid Pages

33 Master Contract or Standalone with ‘Free’ Pages

Note some columns have been removed from the screenshots so that focus is on the important values.
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1. Basic Cost per Copy

This machine has a black meter and a colour meter. No minimum volume. No estimates/averages will be calculated against this 
machine. The machine will have service reads. The only aspect that has changed with this scenario from 3.2 to 3.3 style machines is 
how opening balances are set up.

Meter Setup
 

Service Meters & Current Meter Counts
 

Opening Balance
 

If a read is received for 52,000 black pages and 6,400 colour pages a job similar to the following will be created:
 

 

The only part of the meter setup that would have changed once this is created is the ‘Current Meter Count’ column and the ‘Current 
Meter Counts’ section.
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2. Basic Cost per copy with Estimates 

This machine has a black meter and a colour meter. No minimum volume. Machine allows estimates to be calculated against this 
machine. Under stock is used to track any estimated billing. Machine had a previous actual black and colour read of 45,000 and 
16,000 respectively. Prior to Jim2’s implementation there was also an estimated black and colour read of 4,000 and 800 pages

Meter Setup
 

Opening Balance
 

If there is a second estimated read of 5,000 black pages and 900 colour pages that is entered in the ‘Billing Meter Read’ screen as 
follows:
  

This will produce a job similar to the following:
 

The current meter counts on the machine setup would look similar to:
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If the following month we receive an actual read of 57,000 black pages and 17,400 colour pages, and enter it in via the ‘Billing Meter 
Read’ screen.

 

Jim2 will produce a job similar to the following:

 
Whereby the actual black count is only 3,000 higher than previously estimated, so that is the net number of pages charged to the 
client. We can see the unders are clawed back, and the actual standard page count is increased. The actual colour read still has not 
reached the amount previously estimated, so the entire amount for colour has been clawed back.

 
We can see looking at the black meter it no longer has any unders to clawback, and its entire meter is a ‘standard meter count’. The 
colour meter still has 300 under pages that will be clawed back the next time it is billed.

This allows Jim2 to keep track of actual page counts even if previous estimated billing reads turned out to be too high.
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3. Cost per copy machine with a minimum dollar amount

This machine has a black meter and a colour meter. It has a minimum charge of $50 per month. No estimates/averages will be 
calculated against this machine. The machine will have service reads. The only aspect that has changed with this scenario from 3.2 to 
3.3 style machines is how opening balances are set up.
   

The first month we get a read of 53,000 for black and 10,400 for colour and the following job is created:

 
In this instance the minimum charge is not required because we have billed the client the minimum dollar amount.

If in the second month we record a reading for 55,000 black and 10,500 for colour and the following job is created:
 

In this instance the black and colour meters only charge the client $30 ex. tax ($33 inc. tax), so the minimum charge ‘meter’ makes up 
the difference so that the client is billed the correct minimum amount of $50 ex. tax ($55 inc. tax).
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4. Cost per copy machine with a minimum dollar amount for black only

This machine has a black meter and a colour meter. It has a minimum charge of $50 on the black meter only per month. There is no 
minimum dollar amount for colour. No estimates/averages will be calculated against this machine. The machine will have service 
reads. The only aspect that has changed with this scenario from 3.2 to 3.3 style machines is how opening balances are set up. Similar to 
scenario 3, the only difference with the meter set up is that the minimum charge is linked to the black meter
 

If we use the same scenario as before, where we receive a reading of 53,000 for black and 10,400 for colour, this time the following job 
is created:
 

If we don’t having ‘kitting’ turned on in options a similar result occurs.
 
It is worth noting that the macro for the Min Charge stock has the following value:
{{Project.Meter.Counter Name’ = ‘}}{{Project.Meter.Min - Base TF’ ‘}}{{‘for ‘Project.Meter.Linked Meter.Counter Name}}

We can see that the macro uses the ‘.Linked Meter.Counter Name’ to display the fact that this minimum only applies to black.

In scenario 3, where the minimum charge was not linked, this expression would have evaluated to nothing, and so it didn’t display ‘for’ 
at all.
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5. Cost per copy machine with a minimum volume for black

This machine has a black meter and a colour meter. The black meter has a minimum volume of 4000 pages on it per month. No 
estimates/averages can be calculated against this machine (both averages and minimum volumes use unders to bill so the two 
features are mutually exclusive). The advantage of having a minimum volume is that the minimum charge increases as soon as you 
change the page rate.

Using the same scenario 53,000 for black and 10,400 for colour, this time the following job is created. The shortfall is made up by 
charging 1000 ‘under’ pages:
 

If the following time we get a reading for 58,000 for black and 10,700 for colour, the following job charges ‘over’ pages. In this 
particular case the fact that there are 1000 pages in ‘overs’ is hidden inside a kit.
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6. Cost per copy machine with a base charge

This machine has a black meter and a colour meter. There is also a rental charge of $100 per month. The only aspect that has changed 
with this scenario from 3.2 to 3.3 style machines is how opening balances are set up.

Using the previous set of reads of Black 53,000 and Colour 10,400 produces the following:
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7. Cost per copy machine with a base charge and minimum

This machine has a black meter and a colour meter. Between both meters there is a $50 minimum charge. There is also a rental charge 
of $100 per month. The main aspect that has changed between 3.2 & 3.3 machines is that the base charge is excluded from the 
minimum charge calculation.
 

This time there is a read of 52,000 black and 10,150 for colour. The resulting job would look similar to the following:
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8. Cost per copy machine with a black A3 and separate black A4 meter
 
The client gets charged double the price for each A3 page
 

So an A4 read of 56,000 and an A3 read of 24,000 produces the following job:
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9. Cost per copy machine with a black A3 and black A4 meter with a minimum volume over the two 
meters

This machine has a minimum volume of 10,000 pages per month. Each A3 page counts for 1.5 A4 pages.

Standard Billing
 

Unders/Overs Billing
 

Toner Setup
 

Notice that the ‘Total Black (Calculated)’ meter had its standard meter set as ‘Non Billable’. Normally, this means the meter would be 
discounted at 100%. For a calculated meter however, it means that it is charged at $0.00. We do not want to bill the standard billing 
because this will be billed on the ‘Black’ and ‘Black A3’ meters themselves. The unders information is only required because we are 
going to bill a minimum of 10,000 black pages and this will make up the shortfall. We put in an over rate of $0.00 because again, the 
actual page counts will be billed on the ‘Black’ and ‘Black A3’ meters themselves. The last thing to note is that the ‘A4 Ratio’ of the 
‘Black A3’ meter is 1.5, meaning that each A3 page counts as 1.5 pages. This means that all of the ‘Total Black (Calculated)’ stock 
needs to have a quantity that can go to 1 decimal place.

When entering the read you are only required to enter in the Black & Black A3 values. 
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The job that is created is as follows:
 

We can see that the MC.BLACK.TOTAL stock has a quantity of 8,000. This is 5,000 (A4) + 1.5 X 2,000 (A3). This is charged at $0.00. There is 
then an under charge of 2,000 pages to bring the total black meter up to the minimum volume of 10,000 pages.

If the following month we go over the minimum volume by having a Black read of 63,000 and a Black A3 read of 23,500:
 

We can see the A4 & A3 are billed as normal. By themselves they haven’t gone over 10,000 pages until you consider the 1.5 page 
weighting that A3 pages have. Once this is taken into consideration the total meter isn’t required to bill anything as the 10,000 standard 
pages are billed at $0.00 as are the 250 overs pages.
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10. Cost Per Copy Machine Serviced By Third Party 

A machine with only a black meter is serviced by an agent. At the time of billing the client you want to raise a purchase order for the 
amount you expect to be billed by the agent.
  

 
 
3rd Party PO meters have opening balances exactly the same as a black, colour or scan meter.
 

We can change the macro on the 3rd Party PO stock (MC.BLACK.COST) so that it includes information that makes it easy for the agent 
to identify the machine. The first line of the macro is the following:

{{‘Client=’Project.Card.Name’ ‘}}{{‘Make=’Project.Item.Make’ ‘}}{{‘Serial #=’Project.Serial #’ ‘}}

Entering in a read for 56,500 black produces the following job:
 

The Billing job now has a hidden cost, which links to a purchase order that Jim2 creates. 
 

The default behaviour is to create a PO, or if one exists, to consolidate machines onto a single PO.
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11. Cost per Copy Machine Serviced by Third Party with a Minimum Volume Charge 

A machine with only a black meter is serviced by an agent. The agent has negotiated a minimum volume charge for the machine. At 
the time of billing the client, you want to raise a purchase order for the amount you expect to be billed by the agent.
 

 

The same principle of unders and overs can also apply to 3rd Party PO meters. Note that the minimum volume for the PO meter is 1,000 
and the minimum volume for the black meter is 2,000.

If a read of 57,300 is received for black the job produced will look similar to:
 

The linked purchase order lines produced are
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12. Cost per Copy Machine Serviced by Third Party with a Minimum Charge 

A machine with only a black meter is serviced by an agent. The agent has negotiated a minimum charge for the machine. At the time 
of billing the client you want to raise a purchase order for the amount you expect to be billed by the agent.
  

In this case a read of 57,750 produces the following job:
 

And the following lines on a linked PO created
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13. Cost per Copy Machine Serviced by Third Party with a Base Charge 

A machine with only a black meter is serviced by an agent. The agent has negotiated a base charge for the machine. At the time of 
billing the client, you want to raise a purchase order for the amount you expect to be billed by the agent.

  

The restriction on 3rd Party PO Base meters is that they also must be linked to another meter.
If we receive a read of 59,000 for black the following job is produced:
 

With the following linked purchase order lines also produced:
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14. Cost per Copy Machine Billing Exact Amount Using a Balancing Meter 

A machine with only a black meter is billed to a client. The client themselves calculate what the exact amount charged should be. In 
some instances this differs from the amount charged by Jim2 due to rounding differences. This machine has a balancing meter which 
uses journal stock to make the amounts match exactly.
 

 
Note that there is no rate specified for the balancing meter. A read is received for 58,716 pages and the client has calculated they 
should be charged $171.70. 
 

The total is specified in the ‘Job Total’ field. After Jim2 calculates its total it determines the balancing meter should charge -$0.0052 to 
match the total precisely. The job produced is as follows:
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15. Service and Finance Split and Billed as a Single Amount 

This machine bills the client a service component, and a finance component. Internally you want to keep track of the income split, 
but you want to bill the client a single combined amount. This assumes you have kitting enabled in options (Tools | Options | Project | 
Machines | Linked Meter Kit Stockcode).

Standard Meters
 

 
Under/Over Meters 

 
Both meters have independent opening balances. In this case you need to ensure they are the same. Jim2 will by default give you a 
chance to enter in the ‘primary’ black meter, and then automatically populate the value of the finance meter to be the same as the 
current meter count of the black meter. 
 

Also note that the minimum volume is specified for each meter. Jim2 allows these to operate independently if required.

If we receive a meter read of 53,500 for black the following job is produced:
 

Here, the client sees that it has been billed the minimum of 5,000 pages at $0.01 per page. Internally for accounting purposes we have 
a split between standard billing and unders, as well as a split between service and finance charges.

If the following month we receive a read of 61,000 this job is produced:
 

This overs job again contains the split between service and finance, as well as standard and overs billing. The client again is presented 
with an invoice that contains the total number of pages and the combined rate.
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16. Copy per Copy Machine Billed Using Prepaid Blocks 

This machine has a single black meter and is billed in blocks of 1,000 pages.

   

This machine has been set up with an opening read of 35,000, and with 650 prepaid pages available. Looking at the opening balance 
tab, the price and optional expiry date for the prepaid stock’s opening balance should be specified:

 

If we then enter in a read of 38,400 the following job is created:
 

The use of prepaid pages offsets the actual page count for the period. The effective billable amount for the job is the 3 purchased 
prepaid page blocks.
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17. Copy per Copy Machine Billed Using Expiring Prepaid Blocks 

This machine has a single black meter, and is billed in blocks of 10,000 pages. The prepaid pages expire after 2 months.

Standard/Unders Meters

 
Bulk Pages & Expiry
  

Month 1: a read is received for 63,000 producing the following job:

 

Month 2: a read is received for 67,000 producing the following job:
 

Month 3: a read is received for 69,500. The block purchased in the first month has now expired:
 

The remaining 3,000 pages are expired by reducing the number of prepaid pages (-3,000 PREPAID.BLACK line), and by offsetting this 
against the 3,000 EXPIRED.PREPAID.BLACK, which is a revenue account. A Block of 10,000 pages is then purchased, and the 2,500 
pages actually used to offset against this purchased block.
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18. Cost Per Copy Machine Skip Billing 

This machine has a black meter and a minimum charge of $25.00 per month.
 

The first month no read is recorded and billing is skipped by clicking the ‘Skip Billing Cycle’ button:
 

The following month a read of 64,000 (4,000 pages) is recorded, generating the following job, which calculates the minimum charge as 
2 x $25.00 = $50.00 ex tax:
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19. Cost per Copy Machine with ‘Total’ meter 

A machine has a black and a total meter. The difference between the two meters is the number of colour prints the machine has 
done. Black prints are charged at $0.01 per page and colour $0.10 per page.
 

Notice the ‘Total’ meter is named ‘Total (Linked) in the Meter Type dropdown, and changes to the word Total once it is linked to the 
black meter. The meter expects to receive a read for the combined total, but it will only charge the difference between the meters 
as colour prints. The opening balances are what the meters actually are. In other words, the total meter’s opening balance is not the 
difference between the black meter and the total meter.

We receive a read of 65,000 for black and 87,000 for the total meter:

 

We can see Jim 2 will only bill the difference between the two meters, ie. 
(87,000 – 80,000) – (65,000 – 60,000) = (7,000 – 5,000) = 2,000 pages.

The meter read macros on the job display the actual meter reads. The quantities refer to the billed amount:
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20. Master Contract with Multiple Child Machines

This master contract contains two child machines, one black and one colour machine. Both machines have the same rate for black. 
We can use ‘Master Meters’ to manage rates on child machines. There is no minimum volume for this contract.

 

One child is linked to an item which has its photocopier type set to colour

Both master meters are copied down to the child

 

While the second machine is set to black

For this second machine only the black meters are copied down from the master

To enter reads for all machines under a master you can use the new Master # field in the project/machine list window

If for the Black only machine we receive a read of 33,000 and for the colour machine we receive a read of 54,000 for black and 13,000 
for colour the following two separate jobs are created.

When creating the master job, Jim displays the minimum number of pages (in this case 0 for both)
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This creates a master job that ‘tracks’ all of the pages that have been billed on child machines. The resultant master job has no 
charges, just page counts.

This can allow a master contract to keep track of how far through a volume based contract it is. Opening balances could also have 
been specified for the meters in the master if it was already partway through the contract.
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21. Master Contract with Multiple Child Machines with Different Black Rate

Consider a master machine with some black and some colour machines. Most machines share a common black and/or colour rate 
but there are some machines that charge a different rate. We can use ‘Master Meters’ to manage the majority of machines but 
override any differences by unchecking ‘Master Meter’ on a child machine. Consider the simple example of a master with one black 
and one colour machine. The black machine’s rate is considered the ‘Master Meter’ rate, but the black rate on the colour machine is 
different. We can uncheck the colour machine’s ‘Master Meter’ value on the black meter. This allows it to be different to the master.

Master meter set up is as follows

Colour child machine set up has a black rate of $0.015 per page

While the black machine uses the rate on the master

Entering in reads of 37,000 for the black machine and for the colour machines a black read of 59,000 and colour of 15,000 produces 
the following jobs.

Black machine

Colour machine

And master
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22. Master Contract with Multiple Child Machines and Minimum Volume 

A master has one black and one colour machine. Both machines have the same rate for black. There is a minimum volume of 10,000 
pages per month for black on the contract and 2,000 pages for colour.

The master setup is as follows

Every setting except the ‘Minimum Volume’ (and meter counts) are copied to the child machines

The master also has the additional ‘Child Hide On Invoice’, ‘Child Hide Inv Und’ and ‘Child Hide Inv Over’ values. This allows you to 
specify different visibility settings between master and child machines. In order for the kits on the master and child jobs to appear with 
rates that your client might expect you need to ensure that this visibility matches whether or not they are actually billed. In other words, 
we you need to hide the pages counts on the master that are used to track total pages on child machines. That is, we need to hide 
‘Standard’ and ‘Overs’ on only the master.

In this case we can suggest the following settings on the master

Hide On Invoice = Yes/Checked. Masters do not charge ‘standard’ pages but only track them
Child Hide On Invoice = No/Unchecked. Child machines do charge ‘standard pages’
Hide Inv Und = No/Unchecked. Master do charge ‘under’ pages
Child Hide Inv Und = No/Unchecked. Child machines use ‘unders’ to charge estimates. 
Hide Inv Over = Yes/Checked. Masters do not charge ‘over’ pages but only track them
Child Hide Inv Over = No/Unchecked. Child machines do charge ‘over pages’

In this example, however nothing is hidden. This means that the total ‘click’ on the master will reflect all that has been billed on child 
machines at the expense of changing the ‘Price Ex’ to a meaningless value.

Entering a read of 40,000 for the black machine and for the colour machine entering a read of 63,000 for black and 18,000 for colour 
produces the following jobs. This is before the master job is created so no minimum value calculations have been performed.

Creating the master job creates the following job

The black count is only 7,000 so there are 3,000 pages charge as unders. Under charges are the only amounts that are billed on the 
master (standard and overs charges are billed at $0.00)

The colour count was over the 2,000 minimum so the master just tracks the split between standard and overs pages.

The child machine jobs are amended to the following

No need to change the black only machine as there were no black overs
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For the colour machine the black meter remains unchanged for the same reason, but the colour meter now shows a split between 
standard and overs billing
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23. Master Contract with Multiple Black Machines with A3 & A4 meter and Minimum Volume 

A master has two black machines both which have an A3 and A4 meter. The contract also has a minimum volume of 20,000 pages per 
month. A3 prints count for 1.5 A4 prints.

We set the master up with an A3 and A4 ‘Master Meter’. We also include a ‘Total Black (Calculated)’ menu but we do not set this to 
be a ‘Master Meter’. Similar to a standalone machine we set the ‘Total Black (Calculated)’ meter to be ‘Non Billable’ so that it charges 
standard billing at $0.00 (as the standard amounts are billed on the child machines). We put the unders, overs and minimum volume on 
this ‘Total Black (Calculated)’ meter. We also specify the A3 meter to have an ‘A4 Ratio’ of 1.5

The master set up is as follows

The machines only receive the Black & Black A3 meters

The first machine receives a read of 31,000 for A4 and 6,000 for A3, the second machine a read of 55,000 for A4 and a read of 8,000 for 
A3.

The first child machine job

The second child machine job

The master machines calculates that there were effectively (6,000 + 5,000) + 1.5 X (2,000 + 1,000) = 15,500 pages. The master then bills 
4,500 under pages to make up the minimum volume of 20,000
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24. Master Contract with clawback of all unders and overs at current rate 

A master has two colour machines with a minimum volume for both black and colour. All unders and overs are clawed back at the 
current rate (ABC). There is a minimum of 10,000 pages for black and 2,000 pages for colour. 

First machine has opening balances of 25,000 and 10,000 for black and colour respectively with reads received of 29,000 and 11,500. 
The second has opening balances of 50,000 and 8,000 with reads are received of 53,000 and 9,000.

The following jobs are created

With the master job

We can see that there were 3,000 unders pages for black. As there were colour overs there are no amounts billed on the master and 
the 500 overs are just tracked. The total for the master as a whole is 10,000 X 0.01 + 2,500 X 0.1 = 350.00 ex tax

The following month for the first machine receives reads of 36,000 (7,000 pages) and 12,300 (800 pages) and the second receives reads 
of 58,000 (5,000 pages) and 9,400 (400 pages).

The following jobs are created

With master job
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We can see that some of the unders charged in the first month for the black meter are clawed back in the second month. We can also 
see that all of the overs charged in the first month for colour are clawed back in the second month .

The total for the master as a whole is 12,000 X 0.01 + 2,000 X 0.1 = 320.00 less the 2,000 black overs, less the 500 colour overs. When 
reducing overs we 

a) Reduce overs
b) Reduce unders (If it’s a master)
c) Increase standard billing

Therefore:- 
For black we add (-2,000 X 0.01 - 2000 X 0.01 + 2000 X 0.01) = -20.00 
For colour we add (-500 X 0.1 – 500 X 0.1 + 500 X 0.1) = -50.00

Overall we bill 320.00 – 20.00 – 50.00 = 250.00 ex tax
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25. Master Contract with clawback of all unders at current rate 

A master has two colour machines with a minimum volume for both black and colour. All unders are clawed back at the current rate 
(AUC). There is a minimum of 10,000 pages for black and 2,000 pages for colour. 

First machine has opening balances of 25,000 and 10,000 for black and colour respectively with reads received of 29,000 and 11,500. 
The second has opening balances of 50,000 and 8,000 with reads are received of 53,000 and 9,000.

The following jobs are created

With the master job

We can see that there were 3,000 unders pages for black. As there were colour overs there are no amounts billed on the master and 
the 500 overs are just tracked. The total for the master as a whole is 10,000 X 0.01 + 2,500 X 0.1 = 350.00 ex tax

The following month for the first machine receives reads of 36,000 (7,000 pages) and 12,300 (800 pages) and the second receives reads 
of 58,000 (5,000 pages) and 9,400 (400 pages).

The following jobs are created

With master job

We can see that some of the unders charged in the first month for the black meter are clawed back in the second month. There is no 
clawback for the colour meter as overs were charged in the first month and the contract is set to only clawback unders.
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The total for the master as a whole is 12,000 X 0.01 + 2,000 X 0.1 = 320.00 less the 2,000 black overs. When reducing overs we: 

d) Reduce overs
e) Reduce unders (If it’s a master)
f) Increase standard billing

Therefore:- 
For black we add (-2,000 X 0.01 - 2000 X 0.01 + 2000 X 0.01) = -20.00 

Overall we bill 320.00 – 20.00 = 300.00 ex tax
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26. Master Contract with clawback of all unders and overs at historical rate

A master has two colour machines with a minimum volume for both black and colour. All unders and overs are clawed back at the 
historical rate. There is a minimum of 10,000 pages for black and 2,000 pages for colour. After the first month there is a price increase.

The setup is exactly the same as the previous example, with the exception of the ‘Clawbk Unders’ field, which is now ‘ABH’.

The first month reads and jobs created are exactly the same as the previous example.

Before the second month is billed there is a rate increase to 0.015 per black page and 0.12 per colour page

If again the following month for the first machine receives reads of 36,000 (7,000 pages) and 12,300 (800 pages) and the second 
receives reads of 58,000 (5,000 pages) and 9,400 (400 pages).

The following jobs are created

With master job

We can see on the child jobs that because the black overs were charged in the second month they are also clawed back at the 
second month’s rate. With the colour meter however the overs were charged in the first month at the lower rate, so they are clawed 
back at 0.10 per page. The increase in standard pages occurred in the second month so they are charged at the new rate.

With the master job the opposite is the case. The unders were charged in month 1 for black so they are clawed back at the month 1 
rate. For colour, the unders were charged in the second month, so the amount clawed back is at the new rate.
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The total for the master as a whole is 12,000 X 0.015 + 2,000 X 0.12 = 420.00 less the 2,000 black overs and 500 colour overs. When 
reducing overs we:

a) Reduce overs
b) Reduce unders (If it’s a master)
c) Increase standard billing

Therefore:- 
For black we add (-2,000 X 0.015 - 2000 X 0.01 + 2000 X 0.015) = -20.00 
For colour we add (-500 X 0.01 – 500 X 0.012 + 500 X 0.012) = -50.00

Overall we bill 420.00 – 20.00 – 50.00 = 350.00 ex tax
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27. Master Contract with clawback of all unders at historical rate

A master has two colour machines with a minimum volume for both black and colour. All unders are clawed back at the historical rate. 
There is a minimum of 10,000 pages for black and 2,000 pages for colour. After the first month there is a price increase.

The setup is exactly the same as the previous example, with the exception of the ‘Clawbk Unders’ field, which is now ‘AUH’.

The first month reads and jobs created are exactly the same as the previous example.

Before the second month is billed there is a rate increase to 0.015 per black page and 0.12 per colour page

If again the following month for the first machine receives reads of 36,000 (7,000 pages) and 12,300 (800 pages) and the second 
receives reads of 58,000 (5,000 pages) and 9,400 (400 pages).

The following jobs are created

With master job

We can see on the child jobs that because the black overs were charged in the second month they are also clawed back at the 
second month’s rate. With the colour meter however the overs were charged in the first month at the lower rate, so they are clawed 
back at 0.10 per page. The increase in standard pages occurred in the second month so they are charged at the new rate.

With the master job the opposite is the case. The unders were charged in month 1 for black so they are clawed back at the month 1 
rate. For colour, the unders were charged in the second month, so the amount clawed back is at the new rate.
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The total for the master as a whole is 12,000 X 0.015 + 2,000 X 0.12 = 420.00 less the 2,000 black overs and 500 colour overs. When 
reducing overs we:

d) Reduce overs
e) Reduce unders (If it’s a master)
f) Increase standard billing

Therefore:- 
For black we add (-2,000 X 0.015 - 2000 X 0.01 + 2000 X 0.015) = -20.00 
For colour we add (-500 X 0.01 – 500 X 0.012 + 500 X 0.012) = -50.00

Overall we bill 420.00 – 20.00 – 50.00 = 350.00 ex tax
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28. Master Contract with clawback of open unders and overs at current rate

A master has two colour machines with a minimum volume for both black and colour. Open unders and overs are clawed back at the 
current rate (OBC). There is a minimum of 10,000 pages for black and 2,000 pages for colour. 

The first month’s reads are exactly the same as example 22. The master job is created without ‘leaving unders open’. The jobs created 
are exactly the same.

If in the following month the first machine receives reads of 36,000 (7,000 pages) and 12,300 (800 pages) and the second receives 
reads of 58,000 (5,000 pages) and 9,400 (400 pages). The master job this time is created by clicking the ‘Generate Job Unders Open’. 
The warning that 

‘There are no meters on this Machine that are due to be billed in future periods. Are you sure you want to make unders available for 
future use by these meters?’ is ignored

The following jobs are created.

With the master job

Note that no unders or overs are clawed back. Because the first month was not billed with ‘Leave Unders Open’ they are effectively 
closed off to the second period.

The third month reads of 40,000 (4,000 pages) for black and 13,800 (1,500 pages) for colour for the first machine and reads of 61,000 
(3,000 pages) for black and 10,400 (1,000 pages) for colour for the second machine. 

The master was billed with ‘leave unders open’, although this only affects the calculation for future months, not the current month.

The jobs produced were

With master job
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We can see only 2,000 black overs/unders were clawed back, which was the amount of unders billed in month 2, even though there 
were 3,000 billed in month 3. With colour all 500 overs charged in month 3 are clawed back because there were 800 unders charged in 
month 2.

The invoice for this master as a whole would be (10,000 X 0.01 + 2,500 X 0.1 = 350.00) less the unders clawed back from month 2 (-2000 X 
0.01 – 500 X 0.1 = 70.00). This would produce an invoice for 280.00 ex tax
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29. Master Contract with clawback of open unders at current rate

A master has two colour machines with a minimum volume for both black and colour. Open unders are clawed back at the current 
rate (OUC). There is a minimum of 10,000 pages for black and 2,000 pages for colour. 

The first month’s reads are exactly the same as example 22. The master job is created without ‘leaving unders open’. The jobs created 
are exactly the same.

If again the following month for the first machine receives reads of 36,000 (7,000 pages) and 12,300 (800 pages) and the second 
receives reads of 58,000 (5,000 pages) and 9,400 (400 pages). The master job this time is created by clicking the ‘Generate Job Unders 
Open’. The warning that 

‘There are no meters on this Machine that are due to be billed in future periods. Are you sure you want to make unders available for 
future use by these meters?’ is ignored.

Note that no unders or overs are clawed back. Because the first month was not billed with ‘Leave Unders Open’ they are effectively 
closed off to the second period. Therefore, the jobs that are created are exactly the same as the second period in the previous 
example. 

The third month reads of 40,000 (4,000 pages) for black and 13,800 (1,500 pages) for colour for the first machine and reads of 61,000 
(3,000 pages) for black and 10,400 (1,000 pages) for colour for the second machine. 

The master was billed with ‘leave unders open’, although this only affects the calculation for future months, not the current month.

The jobs produced were

With master job

We can see that the black overs in the second period are not clawed back in the third period because this contract is only set up to 
clawback unders (not overs).

The unders colour unders charged in the second period are however clawed back in this third period. With colour all 500 unders 
charged in month 3 are clawed back because there were 800 unders charged in month 3.

The invoice for this master as a whole would be (10,000 X 0.01 + 2,500 X 0.1 = 350.00) less the unders clawed back from month 2 (– 500 X 
0.1 = 50.00). This would produce an invoice for 300.00 ex tax 
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30. Master Contract with meters with different periodicities

A master has two black machines. The finance company for each machine is billed a minimum volume of 10,000 across the contract 
each month. Every quarter the client is billed any overs.

The master is set to bill monthly, the first period being the 1st May 2013

The ‘Black Finance’ line is charged on a monthly basis (Note: it has nothing in the last ‘Billed’ field) and the ‘Black’ meter is to be billed 
every quarter. The next time the ‘Black’ meter is due to be billed is the 1st July 2013

Other things to note is that the overs are hidden to the finance company so they will only ever see the minimum volume. The standard 
and unders billing are hidden to the client because they will not be charged anything for these amounts. Only the overs quantity will 
appear on the job, ensuring the maths displays nicely.

The other thing to note is that the ‘Minimum Volume’ is always specified at the periodicity of the machine, not of the meter. This allows 
the periodicity of the meter to be changed without having to update the ‘Minimum Volume’ field.

Because as far as the client is concerned it is three monthly periods that make up the quarter we will use ‘Leave Unders Open’ stock 
(Tools | Options | Project | Machines | Leave Unders Available for Clawback). This means we should use one of the ‘Open’ (OUC, 
OBC, OUH or OBH) clawback types. In this case the ‘Clawback Open Unders at Current Rate’ (OUC) is method of clawback is used. 

The first period we receive reads of 30,000 (5,000 pages) and 58,000 (8,000 pages). When billing the master because this is not the end 
of the period we bill using the ‘Generate Job Unders Open’ button

The following child jobs are created

The pages are split between standard and over pages proportionally. The total number of standard pages billed is 10,000. Both of the 
‘over’ lines have a status of hide because we specified ‘Hide Inv Over’.
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The master does not bill any amounts but tracks the pages billed on its child machines

It also has the ‘LEAVE.UNDERS.OPEN’ stock which ensures that any unders charged in the next period will claw back the overs charged 
in this period.

The ‘Black’ meter was not billed this time because it is next due to be billed on the 1st July 2013, as specified by the meter’s ‘Start Date’.

If we invoice this contract using the system ‘Invoice Meters – Master’ report we get the following result

Note that the finance company only ‘sees’ that 10,000 pages were billed, even though there were actually 13,000 pages billed. This is 
due to hiding the overs.

The following month we receive reads of 33,000 (3,000 pages) and 63,000 (5,000 pages). Again, because this is not the end of the 
quarter when billing the master we click the ‘Generate Job Unders Open’ button.

For this period 8,000 pages are billed. This means that the master must bill 2,000 pages in unders. The previous month we had 3,000 
pages in overs so Jim claws back 2,000 of those overs this month. It does this on a proportional basis considering the total over pages 
the child machines have done over both months. 

The first machine had done 1,154 over pages and the second machine had done 1,846. This means that the ratio of the 2,000 overs 
clawed back is 1,154: 1,846.

On the master the 2,000 pages that are billed in unders are also clawed back

This time the ‘Invoice Meters – Master’ report looks like the following

The following month’s reads for the child machines are 39,000 (6,000 pages) and 70,000 (7,000 pages). This time when creating the 
master job we select the ‘Generate Job’ (not the ‘Generate Job Unders Open’) button because this is the end of the quarter.
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The following jobs are generated for the finance company

Because the contract has done overs nothing is billed on the master job.

The invoice displays almost identically to the first month where there were overs as well

The customer ‘overs’ jobs are also generated because it is the end of the quarter. Notice its last read is specific to the meter and 
displays the opening balance of the meter. Also notice that the COUNTER.BLACK stock has a status of Hide. This ensures that the 
quantity of 12, 353 is not included in the kit header. This keeps the maths at the kit header very straightforward (1647 X 0.01 X (1 + 10%) = 
18.1170)

Because of the period of the quarter the master has gone over its minimum volume the master again just tracks the volumes billed on 
its child machines

The customer overs invoice does display the over quantities because they have not been hidden on the jobs.
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31.  Master Contract with average billing

A master with one black and one colour machine receives a read for the both machines the first month. The next month a read is 
received for the black machine but an average read is used for the colour machine. The second month a read is received for both 
machines. The master claws back open unders at the current rate (OUC). The master has a minimum volume of 10,000 for black and 
2,000 for colour

The master has 10,000 black pages and 3,000 colour pages billed against it in the first month.

Notice that because the black total is exactly the same as the minimum volume there are ‘0’ unders billed. This makes it possible 
to know later down the track that the minimum volume at the time was 10,000. If this entry was missing it would be impossible to 
differentiate it between a minimum of 10,000 and a master that had no minimum and had 10,000 black prints.

The second month the first machine receives a read of 35,000 (7,000 pages). No read is received for the colour machine so an estimate 
is used

Again, the master is billed with ‘leaving unders open’. The following jobs are produced

Here we can see that there are two COUNTER.BLACK.UNDER lines. Because this was an estimate the machine was billed using only 
under stock. When we consider the master as a whole, this machine should have been billed 2,000 in overs. If we click on the ellipsis 
(…) at the end of the stock description we see that the ‘UNDER’ stock lines have an attribute of either ‘Under Type’=’Under’ or ‘Under 
Type’=’Over’. The second line in each case has the ‘Under Type’=’Over’. This indicates to Jim that even though this was billed using 
under stock (because it was an estimate), when it comes to ‘over’ calculations this line should be treated as an over.

As far as the master is concerned, these estimated pages are billed as if they were actual page counts
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The next month reads are received for both machines so the estimate is clawed back. The first machine receives a read of 41,000 
(6,000 pages) and the second receives actual reads of 62,000 for black and 16,000 for colour

The master job is then created calculating 4,000 under pages for black and 1,000 over pages for colour.

The estimated machine’s job is amended to the following. As there are no black overs it remains unchanged. 1,000 of the colour pages 
are converted to over pages.
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32.  Master Contract or Standalone with Prepaid Pages

This setup can be used for either a master contract or a standalone machine. The setup for both is identical except that in master 
contract case the prepaid meter is on the master and in the standalone case it is on the standalone machine.

Two black machines on a contract buy pages in 10,000 page blocks. The pages expire if they are not used the in either the month they 
were purchased or the following month.

The first month there are reads of 29,000 (4,000 pages) and 52,000 (2,000 pages).

The master bills the prepaid block and tracks the pages used on the child machines.

The prepaid pages are used on the master offsetting the pages billed on the child machines with the net effect that the client is only 
billed for any blocks purchased.

The following month reads of 32,000 (3,000 pages) and 54,000 (2,000) pages are captured.

Because there are 5,000 pages billed but only 4,000 prepaid pages remaining in the block, another block must be purchased

Again the net effect is the client is billed for one prepaid block at $110.00 including tax.
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The following month reads of 36,000 (4,000 pages) and 57,000 (3,000 pages) are captured. This time because there were 9,000 prepaid 
pages remaining in the block the client is not charged an amount. The following job is generated for the master

The next month reads of 42,000 (6,000 pages) and 62,000 (5,000 pages) are received. Any remaining pages purchased in month 2 
that were not used in month 2 or 3 are now expired. Looking at the master job we see that 2,000 pages are expired and ‘used’ on the 
master itself. The 11,000 pages now require 2 blocks of 10,000 pages to be purchased.

Looking at the meter setup for the master we can see that there are 9,000 prepaid pages remaining. The 2,000 in the under column 
refers to the total number of pages that have been expired over the life of the contract.
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33.  Master Contract or Standalone Machine with ‘Free’ Pages

This setup can be used for either a master contract or a standalone machine. The setup for both is identical except that in master 
contract case the prepaid meter is on the master and in the standalone case it is on the standalone machine.

As a part of winning a contract the sales person has given away 20,000 ‘free’ black pages to the customer. The master contains two 
black machines.

This set up for this scenario is nearly the same as for prepaid pages (see ‘Master Contract with Prepaid Pages’). The difference is that 
there is no ‘Prepaid Bulk Pages’ specified. You can still specify an expiration frequency if required.

 

  

Because the ‘free pages’ are not sold automatically (because there is no block size specified) a separate job is required to ‘give away’ 
the free pages. This involves creating a job which assigns the free pages to the machine.

We recommend setting up a Stock GL group such as ‘Meter Black Prepaid Purchase’ linked to a liability GL account

Another stock GL group such as ‘Meter Black Prepaid COGS’ (Cost of goods sold) is also required.

The stock codes are set up as follows.

Note that the BLACK.FREE.COGS stock code is not used in the meter set up. It exists to offset the BLACK.FREE stock on the job which 
gives away the free pages. In order to do this we recommend you use a dynamic kit.

The ‘kit’ consists of the BLACK.FREE and BLACK.FREE.COGS stock.

A job is then created to ‘give away’ the free pages. This job is linked to the master contract. This can be created by going to the 
master contract/project and clicking ‘Add Jobs’ | ‘Consumable Job’.

The BLACK.FREE.SUPPLY stock is then added to the job. The price for the BLACK.FREE stock is manually changed to the price per black 
page. The BLACK.FREE.COGS is changed to the negative of this amount. Finally the number of pages given away is entered in as the 
ordered quantity. This zero dollar job is then invoiced. The date due on the job is the earliest date these prepaid pages can be used. 



Jim2® Business Engine version 3.3 | Release Notes | Page 91  

The ‘next bill’ date on the master contract must be on or after this date for the pages to be used.

This allocates 20,000 pages to the master’s ‘Free Pages’ meter.

 

If we then receive reads of 33,000 (8,000 pages) and 57,000 (7,000 pages) it creates standard jobs for the child machines.

The amounts charged on the child machines are offset by the free pages being used on the master

If the meter setup on the master is then viewed it will show that there are only 5,000 free pages remaining.

If the following month reads of 39,000 (6,000 pages) and 62,000 (5,000 pages) it creates the following jobs.

The master can only use the remaining 5,000 free pages. Unlike the standard ‘prepaid pages’ situation there are no further ‘free pages’ 
purchased. This means the client is billed for the remaining 6,000 pages.


